
  

 MIKE 2017 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MIKE 11 

River and Channel Modelling 

Short Introduction - Tutorial 
 

 

 

 

 

 

 

 



 

 mike_11_short_introduction-tutorial.docx/TSJ/2017-09-25 - © DHI  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

DHI headquarters 

Agern Allé 5 

DK-2970  Hørsholm 

Denmark 

+45 4516 9200  Telephone 

+45 4516 9333  Support 

+45 4516 9292  Telefax 

mike@dhigroup.com 

www.mikepoweredbydhi.com 

 

 



  

 MIKE 2017 

 

 

PLEASE NOTE 
 

 

 

COPYRIGHT This document refers to proprietary computer software, which is 

protected by copyright. All rights are reserved. Copying or other 

reproduction of this manual or the related programmes is 

prohibited without prior written consent of DHI. For details please 

refer to your ‘DHI Software Licence Agreement’. 

 

LIMITED LIABILITY The liability of DHI is limited as specified in Section III of your ‘DHI 

Software Licence Agreement’: 

  ‘IN NO EVENT SHALL DHI OR ITS REPRESENTATIVES 

(AGENTS AND SUPPLIERS) BE LIABLE FOR ANY DAMAGES 

WHATSOEVER INCLUDING, WITHOUT LIMITATION, SPECIAL, 

INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR 

DAMAGES FOR LOSS OF BUSINESS PROFITS OR SAVINGS, 

BUSINESS INTERRUPTION, LOSS OF BUSINESS 

INFORMATION OR OTHER PECUNIARY LOSS ARISING OUT 

OF THE USE OF OR THE INABILITY TO USE THIS DHI 

SOFTWARE PRODUCT, EVEN IF DHI HAS BEEN ADVISED OF 

THE POSSIBILITY OF SUCH DAMAGES. THIS LIMITATION 

SHALL APPLY TO CLAIMS OF PERSONAL INJURY TO THE 

EXTENT PERMITTED BY LAW. SOME COUNTRIES OR 

STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION 

OF LIABILITY FOR CONSEQUENTIAL, SPECIAL, INDIRECT, 

INCIDENTAL DAMAGES AND, ACCORDINGLY, SOME 

PORTIONS OF THESE LIMITATIONS MAY NOT APPLY TO 

YOU. BY YOUR OPENING OF THIS SEALED PACKAGE OR 

INSTALLING OR USING THE SOFTWARE, YOU HAVE 

ACCEPTED THAT THE ABOVE LIMITATIONS OR THE 

MAXIMUM LEGALLY APPLICABLE SUBSET OF THESE 

LIMITATIONS APPLY TO YOUR PURCHASE OF THIS 

SOFTWARE.’ 
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1 Background 

MIKE 11, developed by DHI, is a software package for simulating flows, water quality and 

sediment transport in estuaries, rivers, irrigation channels and other water bodies. 

 

This manual provides a short description of MIKE 11 with emphasis on the basic features 

and usage of the fully Windows integrated Graphical User Interface of MIKE 11. 

Additionally, a tutorial is provided to introduce MIKE 11 to users with no or very little 

experience with MIKE 11 and guide them through the set-up and simulation of a simple 

river system. 

 

Presentation of results from MIKE 11 is carried out with MIKE View. MIKE View is a 

Windows based result presentation and reporting tool for MIKE 11. A tutorial is described 

in order to familiarise MIKE 11 users with the features and usage of MIKE View.  

 

More detailed description of MIKE View is supplied in a separate MIKE View manual. 

 

The MIKE 11 User Guide and MIKE 11 Reference Manual complements the present 

manual and the Online Help with essential information on conceptual and algorithmic 

implementation of the main processes treated by MIKE 11, as well as descriptions of 

applied modelling techniques. 

 

To help you to learn using MIKE 11 efficiently, the online help and the present manual can 

be used to guide you through the facilities of MIKE 11. 
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2 Before You Begin 

2.1 Product Support 

If you have questions concerning MIKE 11 or problems with the MIKE 11 software, please 

consult the present manual, the MIKE 11 User Guide, MIKE 11 Reference Manual or the 

online help.  

 

If you have access to the Internet, You may also have a look under ‘Frequently Asked 

Questions’ (FAQ), User Forum or ‘Tips & Tricks’ in the Support section of the MIKE 

Powered by DHI’s home page:  

http://www.mikepoweredbydhi.com/  

 

If you cannot find the answer to your queries, please contact your local MIKE Powered by 

DHI support centre. 

 

In countries where no local MIKE Powered by DHI support centre is present you may 

contact DHI headquarters directly, by mail, phone, fax or e-mail: 

 

DHI  

Agern Allé 5  

2970 Hørsholm  

Denmark 

Phone: +45 4516 9200 

Support: +45 4516 9333 

Fax: +45 4516 9292 

mike@dhigroup.com  

www.mikepoweredbydhi.com  

 

If you wish to upgrade or purchase additional modules on an existing installation, please 

contact your local MIKE Powered by DHI support centre or DHI headquarters. 

 

The most efficient way of communicating is by e-mail, allowing us to optimise services to 

our clients. Under normal circumstances, all e-mail messages received at DHI will be 

answered within 24 hours. 

 

When contacting your local MIKE Powered by DHI support centre or the MIKE Powered 

by DHI support centre at DHI headquarters, you should have the following information at 

the ready: 

 

• The version number of your MIKE 11 installation. 

• The exact wording of any message that appears on the monitor (in case of software 

problems). 

• A description of what happened and what you were trying to do when the problem 

occurred. 

• A description of how (if at all) you tried to solve the problem. 

• The type of hardware you are using including available memory. 

• If you contact DHI by e-mail, please attach the set up that causes problems. 

http://www.mikepoweredbydhi.com/
mailto:mike@dhigroup.com
http://www.mikepoweredbydhi.com/
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2.2 THE ACADEMY by DHI Training Courses 

MIKE Powered by DHI software is often used to solve complex and complicated 

problems, which require a good perception of modelling techniques and the capabilities of 

the software. Therefore, THE ACADEMY by DHI offers a wide range of standard courses 

in the use of our MIKE software products. 

 

The courses are advertised through THE ACADEMY by DHI’s home page:  

 

http://www.theacademybydhi.com/courses-and-events-calendar. 

 

THE ACADEMY also offers tailored training courses based upon your own data and 

designed according to your specific needs 

 

If you have any questions about our standard courses or any request for a tailored 

course, please do not hesitate to contact us: courses@dhigroup.com. 

 

2.3 Comments and Suggestions 

Success in perception of the information presented in this document, together with the 

user's general knowledge of river systems, hydrology, hydrodynamics and experience in 

numerical modelling is essential for getting a maximum benefit from MIKE 11. This implies 

that the quality of the documentation, in terms of presentation style, completeness and 

scientific competence, constitutes an important aspect of the software product quality. 

DHI will, therefore, appreciate any suggestion that will contribute to the improved overall 

quality of the future editions of MIKE 11. 

 

Please give us your contribution by e-mail to mike@dhigroup.com. 

 

http://www.theacademybydhi.com/courses-and-events-calendar
mailto:courses@dhigroup.com
mailto:mike@dhigroup.com
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3 Welcome to MIKE 11 

3.1 Introduction 

MIKE 11 is part of the MIKE Powered by DHI software products based on the MIKE Zero 

platform, comprising a fully Windows integrated Graphical User Interface, which conforms 

to the evolving standards for Windows based software. MIKE 11 contains the mature, 

well-known and well-tested computational core, which has formed the basis for the long 

history of MIKE 11 releases. MIKE 11 is a true 64-bit application securing fast 

computational speed or number crunching in comparison with earlier MIKE 11 versions. 

 

By applying MIKE 11 it is possible to answer questions such as: 

 

• The exceedance levels in case of flooding – and at which locations will flooding 

occur? 

• The implications of introducing e.g. flood control measures? 

• The long-term environmental impact affected by changing pollution loadings? 

• Where is the sediment deposited in the river system - and what are the overall 

morphological changes? 

• The peak concentrations of pollutants at specific locations after e.g. heavy polluted 

loadings from urban catchments, CSO’s (combined sewer overflow) or industry 

plants? 

And much more… 

 

3.2 Short Description of MIKE 11 

MIKE 11 is a professional engineering software package for the simulation of flows, water 

quality and sediment transport in estuaries, rivers, irrigation systems, channels and other 

water bodies. 

 

MIKE 11 is a user-friendly, fully dynamic, one-dimensional modelling tool for the detailed 

analysis, design, management and operation of both simple and complex river and 

channel systems. With its exceptional flexibility, speed and user friendly environment, 

MIKE 11 provides a complete and effective design environment for engineering, water 

resources, water quality management and planning applications. 

 

The Hydrodynamic (HD) module is the nucleus of the MIKE 11 modelling system and 

forms the basis for most modules including Flood Forecasting, Advection-Dispersion, 

Water Quality and Non-cohesive sediment transport modules. The MIKE 11 HD module 

solves the vertically integrated equations for the conservation of continuity and 

momentum, i.e. the Saint Venant equations. 

 

Applications related to the MIKE 11 HD module include: 

• Flood forecasting and reservoir operation 

• Simulation of flood control measures 

• Operation of irrigation and surface drainage systems 
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• Design of channel systems 

• Tidal and storm surge studies in rivers and estuaries 

 

The primary feature of the MIKE 11 modelling system is the integrated modular structure 

with a variety of add-on modules each simulating phenomenon related to river systems. 

 

In addition to the HD module described above, MIKE 11 includes add-on modules for: 

• Hydrology  

• Advection-Dispersion 

• Models for various aspects of Water Quality 

• Cohesive sediment transport 

• Non-cohesive sediment transport 

 

3.3 MIKE 11 

The present generation of MIKE 11 combines the features and experiences from the 

previous MIKE 11 generations, with the powerful Windows based user interface including 

graphical editing facilities and improved computational speed gained by the full utilisation 

of 64-bit technology.  

 

On the input/edit side MIKE 11 features: 

• graphical data input/editing  

• simultaneously input/editing of various data types 

• copy & paste facility for direct import (export) from e.g. spread sheet programs 

• fully integrated tabular and graphical windows 

• importing of river network and topography data from ASCII text files 

• user defined layout of all graphical views (colours, font settings, lines, marker types 

etc.) 

 

On the output side, advanced presentation facilities are available, including: 

• coloured horizontal plan graphics for the system data and results 

• animated presentation of results in horizontal, longitudinal and time series plot 

• synchronised animation of results  

• presentation of external time series 

• copy & paste facility for exporting result tables or the presentation graphics into other 

applications (spread sheet, word processing or others) 

 

3.4 What’s New 

Every new release of MIKE 11 comprises new modules, new features and/or corrections 

to problems or significant inconsistencies discovered in previous releases.  

 

Release Notes on every MIKE product are prepared with every new release and new 

features and other general improvements are described in these. 
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4 Getting Started 

4.1 Hardware Requirements 

MIKE 11 is available for PCs with Microsoft Windows based operating systems. For 

specifications on supported Windows versions, please refer to the release notes. Using 

dynamic memory allocation the required RAM in MIKE 11 varies depending on the actual 

set-up and model domain. As a general guideline we usually recommend minimum 1 GB 

RAM and similarly at least 1 GB of free disk space. 

 

4.2 Installation of MIKE 11  

To install MIKE 11 safely please follow the instructions given below: 

 

1. If you have a previous version of any MIKE Zero product installed, you must uninstall 

this version initially.  

 

To uninstall MIKE Zero products, use the 'Control Panel → Add/Remove Programs'. 

Occasionally, you will find some files remaining in your installation folder after the 

uninstall procedure, e.g.: 

 

'C:\Program Files (x86)\DHI\2016\MIKE Zero\bin'  or  

'C:\Program Files (x86)\DHI\2016\MIKE Zero\bin\x64' 

 

Make a backup of any personal files or directories you might have placed in this 

directory, and then delete everything. Especially, make sure that the 'bin' directory is 

completely empty.  

 

2. It is strongly recommended that you exit all Windows programs you may have 

running before running the set up program.  

 

3. To install MIKE 11 Release 2017, please download and unpack the installation 

package from our home page: 

 

http://www.mikepoweredbydhi.com/download/MIKE2017  

 

The installation program automatically installs all necessary MIKE 11 files and folders to 

your PC. Additionally, a 'MIKE Zero 2017' group is created, from which you can start the 

‘MIKE Zero’ application. MIKE 11 are accessible as a product type inside the MIKE Zero 

platform.  

 

 

4.3 How to Start MIKE 11 

To start MIKE 11, select the ‘MIKE Zero 2017’ folder from the Start menu and start the 

‘MIKE Zero’ application.  

 

http://www.mikepoweredbydhi.com/download/MIKE2017
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Starting MIKE 11 without a DHI configured Software Key and a valid license file, causes 

the program to run in Demo mode. If this happens, a message box will inform you during 

program initialisation. Running in Demo mode, MIKE 11 supplies full access to all editors, 

input files and editing facilities. However, restrictions apply on the number of items 

allowed, when saving input files and performing computations. 

 

PLEASE NOTE: 

The User Interface of MIKE Zero/MIKE 11 is designed such that a monitor with a 

minimum of Super VGA resolution (1024x768) is required to view the full contents of all 

dialogs.  

 

It is indeed possible to run MIKE 11 on a monitor with smaller resolution, but parts of the 

dialogs can then only be viewed, if the specific window is moved manually by using the 

mouse. 

 

4.4 MIKE 11 Online Help 

Following the standards of true Windows application, MIKE 11 utilises integrated online 

Help supplying descriptive information on each of the editors, dialogs and property pages 

within the system. The online Help supplies explanations on how to operate a specific 

dialog as well as descriptions of the parameters present in the specific page.  

 

The online Help can be activated in several ways, depending on the user’s requirement: 

 

1. Use the Help button:          

To see the description of a specific functionality, press the Help button and move the 

‘?’ to point and click in an editor page or on one of the edit buttons available in the 

editor.  

 

Please note that this help feature is only available in the network editor. 

 

2. <F1> key seeking help on a specific activated editor page; 

To access the help associated with a specific editor property page press the <F1> 

key on the keyboard after opening the editor and activating the specific property 

page.  

 

3. Open the online Help system for scrolling manually after a specific help page;  

Open the online Help system by selecting Help in the main menu bar. 
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5 Working with the MIKE 11 User Interface 

5.1 MIKE Zero Project Files 

With version 2017 of MIKE 11 and other MIKE Zero based software products a new 

concept and a range of new features for managing modelling projects has been 

introduced. On-line help exist for all products and modules inside MIKE Zero and help 

documents can be accessed for further details through the ‘MIKE Zero Documentation 

Index’ which is also located and accessible from the MIKE Zero 2017 folder in the 

Windows Start menu. 

5.2 MIKE 11 Editor Files 

5.2.1 File handling 

With respect to file handling, MIKE 11 is operated just like any other Windows application. 

That is, all file-related operations are performed through the File menu on the Main Menu 

bar. Please note that the content of the File menu will change depending on which MIKE 

11 editor is in focus at the time where the File menu is opened.  

An example of the File menu is shown in Figure 5.1. 

 

 
 
Figure 5.1 File menu from MIKE 11 Main Menu bar 

 

Creating new editor files 

To create a new editor file, select File from the main menu bar and choose New → File to 

open the ‘New’ dialog (alternatively press Ctrl+N), see Figure 5.2. Expand the tree view in 
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the dialog by clicking ‘+’ or double-clicking the MIKE Zero and MIKE 11 icons. The tree 

view in the ‘New’ dialog shows a list of available Data editors in the MIKE Zero 

environment. 

 

 
 
Figure 5.2 ‘New File’ dialog for generating a new MIKE 11 input file 

 

Select the type of file you wish to create and press the OK button or double-click the 

specific icon. Selecting an item from the ‘New’ dialog automatically opens the specific 

editor and data input can commence. 

 

Open existing editor files 

To open an existing editor file, select File → Open → File from the Main Menu bar to 

activate the standard Windows ‘Open file’ dialog (alternatively press Ctrl+O). Activate the 

file type combo box by clicking the arrow button in the ‘Files of Type’ field and select the 

type of file you wish to open, see Figure 5.3.  
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Figure 5.3 File open dialog including file type selection combo box   

 

After selection of the editor file to open, the corresponding editor will be automatically 

opened with the content of the selected editor file. The content of the loaded data file can 

now be modified. 

 

Upon termination of an input editing session, the editor file is saved by selecting File + 

Save from the main menu bar. You are automatically prompted to specify an editor 

filename. 

 

IMPORTANT NOTICE:  

When saving editor files, please specify the full filename including the specific extension 

for the editor file used. It is essential that all input files are saved with the correct 

extension before a simulation is performed. (Example: saving a Network editor file with 

the name ‘TEST’, you should specify ‘TEST.NWK11’ to ensure that all files holds the right 

extension as this is a must in order for the simulation part of MIKE 11 to work properly! 
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5.2.2 File types 

MIKE 11 includes multiple editors each operating on different types of data. Data from 

these editors must be saved in separate editor files – utilising the default MIKE 11 file 

extensions as listed below.  

 

MIKE 11 Editor File Extension 

Network editor *.NWK11 

Cross-section editor  *.XNS11 

Boundary editor *.BND11 

Time series files *.DFS0 

HD parameter file *.HD11 

AD parameter file *.AD11 

MIKE ECO Lab parameter file (WQ) *.ECOLab11 

ST parameter file *.ST11 

FF parameter file *.FF11 

Rainfall Runoff parameter file *.RR11 

Simulation editor *.SIM11 

Result files *.RES11 

 

5.3 Integrating Editors – the Simulation Editor 

MIKE 11 comprises a number of different editors in which data can be implemented and 

edited independently of each other. As a consequence of the system of separated editor-

files, no direct linkage exists between the different editors if they are opened individually. 

That is, it will not be possible to e.g. view the locations of cross-sections specified in the 

cross-section file in the Graphical view of the network editor (Plan plot) if these editors are 

opened individually. 

 

The integration and exchange of information between each of the individual data editors is 

achieved by use of the MIKE 11 Simulation editor. The Simulation Editor serves two 

purposes: 

 

1. It contains simulation and computation control parameters and is used to start the 

simulation.  

 

2. It provides a linkage between the graphical view of the network editor and the other 

MIKE 11 editors as illustrated in Figure 5.4.  
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Figure 5.4 The MIKE 11 Simulation editor 

 

Editing of cross-sections could be a typical example, where cross-sections can be 

selected from the graphical view in order to open the cross-sections for editing in the 

cross-section editor. 

 

The linkage requires a file name to be specified for each of the editors. File names 

are specified on the Input Property Page of the simulation editor.  

 

Once the editor filenames are specified on the Input page, the information from each of 

the editors is automatically linked. That is, you will be able to display and access all data 

from the individual editors (such as cross-sectional data, boundary conditions and 

different types of parameter file information) on the graphical view of the river network 

editor. 

 

5.4 Working with the Network Editor 

The Network editor is a very central unit in the MIKE 11 Graphical User Interface. From 

the graphical view (the plan plot) of the network editor, it is possible to display information 

from all other data editors in MIKE 11. The Network editor consists of two views, a tabular 

view, where the river network data are presented in tables, and a graphical view, where 

graphical editing of the river network can be performed as well as data from other editors 

can be accessed for editing, etc. 

 

The main functions of the network editor are: 

 

• To provide editing facilities for data defining the river network, such as  

- digitisation of points and connection of river branches, 

- definition of weirs, culverts and other hydraulic structures, 

- definition of catchments connecting the river model to a rainfall run-off model. 

 

• To provide an overview of all data included in the river model simulation.  

Overview is provided via the possibility of presenting items from the different data 

editors on the plan plot, graphical view. The different items can be presented using 

symbols and lines of different colours and size – all controlled by the user via the 

‘Settings’, ‘Network’ dialog from the graphical view. 

 

The tabular and the graphical view of the Network editor are shown in Figure 5.5. 
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Figure 5.5 Network editor, Tabular and Graphical view 

 

5.4.1 Graphical view 

The graphical view is opened as default when a river network file is opened or created. 

Additional graphical views can be opened using the ‘New window’ facility in the Window 

Menu in the Main menu bar. When creating a new network file, the user is prompted to 

define Area Co-ordinates. These define the co-ordinate system of the plan in which the 

river system will be digitised. 

 

The Graphical editor of MIKE 11 provides a large number of facilities for editing and 

presentation of the river network.  

 

The main features comprise: 

 

• Network toolbar for graphical editing. 

 

 
 

The tools necessary for creating or editing the river network can be accessed from 

the network toolbar. That is, tools can be selected for digitising single or multiple 

points, connecting points and branches, merging or cutting branches, deleting points 

or branches etc. 

 

• Right mouse pop-up menu. 

From the graphical window, it is possible to activate a number of editing facilities 

from the editor’s right mouse pop-up menu.  

 

To edit an object through the pop-up menu, place the cursor at a network component 
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(e.g. a point, a branch or any other symbol) and press the right mouse button to 

activate the menu.  

 

Selecting ‘Edit…’ gives a possibility of editing any object in the vicinity of the selected 

point. 

 

Use the ‘Insert ’ entrance to insert a new object at the selected point in the network. 

Selecting an entrance from one of the Insert’s sub-menus will open the 

corresponding editor.  

 

‘Point properties’ gives a possibility for changing the selected point’s co-ordinates 

and chainage (if chainage type is selected as ‘User Defined’). 

 

• Zoom functions. 

Zoom functions (zoom in, out and previous zoom) can be activated from the zoom 

toolbar buttons or from the right mouse pop-up menu. To zoom in, click and drag 

until the zoom selection square covers the area in the horizontal plan, which should 

be enlarged. 

 

Please note that the shape of the zoom-in selection area is identical to the shape of 

the graphical view window.  

 

• User-defined settings for display of river network components. 

The drawing style, size and colours of points, branches and other network 

components presented in the graphical view can be controlled from the ‘Graphical 

Settings’ page in the Network Dialog. The Network dialog is activated from the 

Settings Menu in the Main menu bar  

 

• Background images. 

Using the Layers menu from the Main menu bar, it is possible to import one or more 

images as a background map for the river network. Image-files must be saved in 

either GIF- or BMP-format. 

 

Location of the image(s) in the horizontal plan can be modified by selecting the 

image (a red square appears around the image when selected), activate the ‘Image 

Co-ordinates’ entry from the right mouse pop-up menu, and it will then be possible to 

alter the co-ordinates of the specific image.  

 

Thereby, it is also possible to import multiple images of selected areas within the 

same river network file. 

 

• Auto functions. 

In the ‘Network’ menu under the Main menu bar you can activate facilities for auto 

generating network components. E.g. automatic connection of branches following 

logical user-defined specifications, automatic generation of boundary conditions at all 

open ends and automatic update of chainages in the entire network in case points 

have been added, moved or deleted. 

 

• Longitudinal profile. 

The Longitudinal profile feature is only available if the network file has been opened 

through a simulation editor where a cross-section file is associated. It is required to 

associate information on cross-sections, as the bed- and bank-levels are presented 

in the longitudinal profile. 

 

Activate the Longitudinal feature in the ‘View’ menu from the Main menu bar. Place 
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the cursor at a branch and click with the left mouse button to select the upper branch 

in the profile (notice that the branch is highlighted and the cursor changes symbol 

when a branch can be selected). Secondly, place the cursor at the branch which 

should the end branch in the profile and click with the mouse button.  

 

MIKE 11 investigates the number of possible profiles following the path from the first 

branch to the last and if more than one possibility exists, a profile selection dialog will 

appear. Select a profile from the dialog to present the longitudinal profile in a 

separate window.  

 

If only one path exists from the first to the last selected branch, a window containing 

the longitudinal profile will appear immediately. 

 

• Metafile options. 

The river network can be saved in a Windows Metafile format for use in e.g. word 

processors. The metafile feature is activated through the ‘View’ menu in the Main 

menu bar. Metafile can be copied to the clipboard for immediate pasting in to other 

programmes or it can be saved to a file on the disk. 

 

• Import of network co-ordinates from ASCII files. 

Branch and point (cross-section) data can be imported from ASCII text-files. File 

format is described in the On-line Help system. 

 

5.4.2 Tabular view 

The tabular view is opened manually by selecting the ‘Tabular View…’ item in the View 

Menu (hotkey combination is CTRL+T) or automatically, when editing an existing network 

object through the right mouse Pop-up menu. 

 

The dialog for the tabular view contains a number of property pages. A short description 

of the content and purpose of each property page is given below. For a more 

comprehensive description on some of the items reference is made to the On-line Help 

system: 

 

Points 

The points’ property page offers a possibility of editing co-ordinates and river chainages of 

the points digitised in the graphical view (horizontal plan plot).  

 

Important to notice on this property page is the column; ‘Chainage type’ where two 

options are available: ‘System Defined’ and ‘User Defined’ chainage: 

 

• ‘System Defined’ chainage means that MIKE 11 automatically calculates the 

chainage from the digitisation (distance from neighbouring points calculated from the 

plan plot co-ordinates).  

• ‘User Defined’ chainage means that the user can manually specify fixed chainages 

for specific reference points (e.g. hydraulic structures, bridges etc., which have been 

surveyed and found to have a specific location and chainage).  

 

Additionally, it is recommended always to specify the first and last point in each 

branch as User defined, as this will ensure that the length of the river system is 

exactly as required.  
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PLEASE NOTE:  

The points’ information in this property page only includes digitised points. Digitised points 

are not used in the computation – only for presentation of the plan plot of the river system.  

 

Computational points (grid points) used in the computation can be presented in the ‘Grid 

Points’ property page. 

 

Branches 

In the ‘branches’ page, specifications are made on the river branches included in the set-

up. Initially, a River name must be specified in the ‘Name’ column. Afterwards, the 

remaining columns must be edited: 

 

• Topo ID. 

Topo ID is a ‘topographical identifier’, which gives the user a possibility of 

distinguishing between different surveys for the same river system.  

 

Topographical surveys from different years can be stored in the same cross-section 

file if only the Topo ID parameter differs. Therefore, the Topo ID specified must 

correspond to a Topo ID defined in the cross-section file used in the computation – 

otherwise, cross-section data for the simulation cannot be located.  

 

• Flow direction. 

The standard notation of MIKE 11 is that flow direction is positive with increasing 

chainages. This typically requires that the starting point (zero chainage) is defined as 

the upper part and the end the point of the river system are defined in the 

downstream part of the river system. 

 

However, in many surveys, the downstream point (e.g. the river mouth at the sea) is 

the starting point for the river survey, and this point is therefore required to be the 

starting point (zero chainage) for the river model as well. Therefore, in these cases, it 

is required to specify the flow direction as ‘Negative’, as the increasing chainages will 

then be opposite to the standard notation used internally in MIKE 11. 

 

• Maximum dx. 

The maximum selected distance between two neighbouring h-points in the 

computational grid. 

 

• Branch type. 

The branch type can be selected as one of two: 

- Regular: 

The regular branch is the standard branch of MIKE 11 comprising water level 

points at both the up- and downstream end, and an alternating grid of water 

level and discharge points. 

- Link Channel: 

When a branch has been defined as a Link channel type, the ‘Edit Link Channel 

Parameters…’ button is made active. Press the button to open the ‘Link Channel 

Parameters’ dialog where Link channel parameters can be specified.  

 

Important notice: 

After specification of the link channel parameters, it is required to press the 

‘Calculate Q/h relations’ button in order to calculate the link channels Q-h table, 

which is used in the computation. 
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After each modification of any of the link channel parameters, it is required to 

update the Q-h table by pressing the button. 

 

Short description of Link channels: 

Link channels are ideal for modelling the flow paths between e.g. river and 

floodplains. They play an important role in modelling floodplain inundation and 

drainage.  

Also, floodplain cells can be attached to one end of a link channel. The cell is 

represented as a flooded area versus elevation curve based on the additional 

flooded area column of a cross-section in the MIKE 11 cross-section file. 

A link channel can be defined to represent an embankment, a natural levee or a 

tributary. Flow paths can be lumped together to reduce the model size, i.e. 

several tributaries and a river levee may be represented in one link.  

 

Link structures are similar to a long open culvert. Bed levels at the upstream and 

downstream ends, length, bed resistance and head loss coefficient can be 

specified. The cross-section shape is fixed along the entire length and is defined 

by a depth-width table. There is no need for upstream and downstream cross-

sections (as is the case with other structures). 

Each link is treated as a short branch (two h-points and one Q-point).  

- Routing: 

No cross sections are required. Only the flow is calculated, no water levels.  

- Kinematic Routing: 

Kinematic Routing can be used to model the hydraulics of upstream tributaries 

and secondary river branches, where the main concern is to route the water to 

the main river system. The Kinematic Routing method does not facilitate the use 

of structures at Kinematic Routing branches. Moreover the method does not 

account for backwater effects. At kinematic Routing branches, it is possible to 

run the model without information on cross sections. In turn, this indicates that 

Kinematic Routing branches cannot be used to model a looped part of a river 

network. Employment of Kinematic Routing branches requires that all branches 

located upstream of a Kinematic Routing branch are defined in the same way.  

- Stratified: 

Used when a multilayer description is required.  

 

• Connections. 

Upstream and/or downstream branch connections must be specified by River name 

and Chainage, respectively. 

 

Weirs 

Data on broad-crested weirs, special weirs (utilising user-defined Q-h relations), Weir 

Formula 1 and Weir Formula 2 (Honma) are entered in this page. These data comprise 

the location of the weir and the geometry of the weir (that is, a level-/width-table describes 

the geometry). 

 

Valve regulations can be selected to include e.g. flap gates descriptions allowing flow in 

only one direction.  

Additionally, it is possible to select the weir geometry from a cross-section defined in the 

cross-section file. Hence, you must select the ‘Geometry Type’ as ‘Cross-section DB’ and 
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ensure that a cross-section exists at exactly the same location (river name and chainage) 

in the associated cross-section file. 

 

From the entered data, MIKE 11 will calculate Q-h relations for critical flow conditions at 

the weir. In order to compute the Q-h relation, the nearest upstream and downstream 

cross-sections are used. Hence, the user needs to ensure that the Topo ID specified in 

the Branches dialog corresponds to the definitions in the cross-section file. 

 

Please note that: 

1. If no cross-section file is associated to the network file through a simulation editor, it 

is not possible to calculate the Q-h relations for any structure. 

 

2. If changes are made in the nearest upstream or downstream cross-section – or in the 

weir-descriptions, it is required to perform a re-computation of the Q-h table prior to 

the simulation. 

 

Culverts 

Data on culverts must be specified in this page.  

 

The page is very similar to the weir page and offers the same options for specifying valve 

regulations and geometry from a cross-section file. 

 

However, some of the variables are specific for the definition of culverts: 

 

• Invert upstream (U/S) and downstream (D/S) elevation.  

Elevation is the invert elevation at the upstream and downstream end respectively. 

These levels must be higher than the bed level of the cross-sections immediately up- 

or downstream of the culvert, 

• Length. 

Specifies the length of the culvert, 

• Manning’s n. 

Specifies the roughness (material) of the culvert, 

• No. of Culverts. 

Specifies the number of parallel culverts at the same location (using same geometry) 

 

After entering the Culvert data, press the ‘Calculate Q-h…’ button to calculate Q-h 

relations for the culvert. The Q-h relations are given as Q-y relations (where y is the depth 

above invert). Other parameters are given in the ‘Hydraulic Parameters’ page. If desired, 

the orifice flow coefficients can be edited as discussed below.  

 

When calculating the Q-h relation, the types of flow occurring are also listed: 

 

• No Flow. 

No flow occurs at the first level (y=0) and when the valve regulation flag prohibits 

flow in one direction. 

• Inlet C. 

The flow at the inlet is critical. 

• Outlet C. 

The flow at the outlet is critical. A backwater curve using a fine resolution is 

calculated to relate the discharge to the upstream water level in the river. 
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• Orifice. 

The flow at the culvert inlet has an orifice type information. The discharge is based 

on the orifice coefficients shown in the menu. These coefficients can be edited, 

added or deleted, if required. The Q-h relation must be re-calculated after editing the 

coefficients. 

• Full Culvert. 

The culvert is fully wet with a free discharge at the outlet. 

 

Bridges 

Eight types of bridges may be implemented:  

 

• FHWA WSPRO bridge method 

• USBPR bridge method 

• Fully submerged bridge 

• Arch Bridge (Biery and Delleur) 

• Arch Bridge (Hydraulic Research (HR)) 

• Bridge Piers (D’Aubuisson’s formula) 

• Bridge piers (Nagler) 

• Bridge piers (Yarnell) 

 

Pumps 

Data on pumps operated using start and stop levels must be specified on this page.  

The pumps can discharge either internally or externally, and the discharge can be fixed or 

tabulated as a function of the water level difference across the pump. 

 

Regulating 

The regulating page offers a possibility for specifying the discharge at a certain point (e.g. 

a structure) as a function of time or as a function of hydraulic conditions elsewhere in the 

river system. 

 

Two regulating types are available: 

 

• Function of Time. 

The discharge through the structure is specified as a function of time (e.g. if two 

channels are connected to a pump or a turbine). The equation of momentum in the 

specified Q-point in the computational grid is replaced by a discharge/time function.  

 

The actual discharge time series must be specified in the Hydrodynamic Property 

Page using the Boundary Editor.  

 

• Function of h and/or Q. 

Special forms of river regulation can be defined in this page. This structure type is 

applied where discharge through a dam is to be regulated as a function of the water 

level, and the inflow into the reservoir. The location of the structure and the location 
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of the control points (J1 and J2) must be defined together with the regulating 

functions. 

 

The discharge through the dam/structure is calculated as a given factor times the 

discharge or water level as a function of h or Q at two locations (J1 and J2 ) in the 

river model: Q = f(J2) * J1  

 

Control Structures (HD Add-on module)  

Control structures may be used whenever the flow through or above a structure is to be 

regulated by the operation of a movable gate, which forms part of the structure.  

 

For detailed descriptions on how to use the Control Structures module, please refer to the 

MIKE 11 User Guide. 

 

The gate position (operation) during the computation can be saved in the HD Additional 

Output file. To activate this output feature, you must select ‘Velocities in Structures’ output 

in the HD Parameter file, Add. output page. 

 

Dam Break Structures (HD Add-on module) 

The dam break module is used to simulate breach development in a dam structure due to 

overtopping or pipe failure.  

 

The specification of a dam break requires the user to define relevant information from 

each of the following categories: 

 

• Geometric specification. 

Specify the dams crest level and length (perpendicular to the river flow), 

 

• Limit for breach development. 

Regardless of which shape and mode a breach development has been defined, a 

limiting section can be applied. The geometry of the limiting section is specified in the 

cross-section file. 

 

The limiting section allows an irregular shape to be used to define the breach limits. 

This is a useful feature, which allows the natural shape of the river section at the dam 

site to be modelled. Only the section of the dam breach lying inside the limiting 

section is used for calculating the hydraulic parameters. 

 

• Failure moment and mode. 

Failure moment can be specified to commence: 

- As a given number of hours after the start of simulation, 

- At a specified time, 

- At a specific reservoir water level. In this case the dam failure will occur when 

the reservoir water level reaches the specified level. The reservoir water level is 

defined as the water level in the grid point immediately upstream of the dam 

break structure.  

 

Failure mode can be defined as either of the following: 

- ‘Time dependent’  

A known geometry of the breach development is specified as a function of time. 
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The increase in breach dimensions is specified as time series of; Breach width, 

Breach level and Breach slope. 

- ‘Erosion based’ 

The increase in the breach depth is calculated from a sediment transport 

formula (Engelund-Hansen). The increase in breach depth multiplied by the side 

erosion index. If an erosion based failure is specified, further information is 

necessary. This information is entered in a separate dialog, which is activated 

by pressing the ‘Erosion Parameters…’ button. 

 

User defined Structures 

User defined structures is available to create customised structures in MIKE 11. When 

activated, the user defined structure will access a DLL (Dynamic Link Library) written by 

the user. In addition, the DLL can access any variable in MIKE 11 through several 

records. 

 

Tabulated Structures 

Tabulated Structures may be used whenever the flow is determined by a user defined 

relation between the discharge through the structure and the up- and downstream water 

level. The relation is entered in a table. The relation can be expressed in three ways: 

 

• The discharge at the structure is given as a function of up- and downstream water 

level. 

• The upstream water level is given as a function of the discharge and the downstream 

water level. 

• The downstream water level is given as a function of the discharge and the upstream 

water level. 

 

Energy Loss 

The Energy Loss property page is used to define energy losses associated with local flow 

obstructions such as sudden flow contractions or expansions and gradual or abrupt 

changes in the river alignment. Further, a user defined energy loss coefficient can be 

defined. 

 

Routing 

Kinematic routing can be used to model upstream tributaries and secondary river 

branches, where the main concern is to route the water to the main river system. The 

Kinematic Routing method does not facilitate the use of structures at Kinematic Routing 

branches. Moreover, the method does not account for backwater effects. Please check 

the User Guide for details. 

 

MIKE SHE links  

MIKE SHE links are used to link MIKE 11 with the groundwater simulation software 

package MIKE SHE. Details of how to establish such a link is described in the User 

Guide. 
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Catchments 

Catchment discharge can be calculated by the Rainfall Runoff Module and included as 

lateral inflows to the hydrodynamic module. The property page is used to specify the 

locations of catchments in the river network. Lateral catchment inflow can be included in 

either one single point (upstream and downstream chainage must have the same value) 

or distributed along a reach of a river branch.  

 

Grid Points 

The grid points’ property page has two specific purposes: 

 

1. The page presents summary information on the computational network (or grid) 

points prior to the simulation. Press the ‘Generate Grid Point’ button to generate the 

computational grid, which corresponds to the grid used in the computation. 

2. The page can be used to limit the number of computational points saved in result 

files. (e.g. for large models it is desirable to save only those grid points required and 

to discard remaining results thus preventing result files from becoming too large). 

 

The page has no influence on the simulation results and is only for information 

purposes (i.e. the user is not required to the press the Generate Grid Points button 

prior to a simulation.  

 

Each of the property pages provides access to relevant information pertaining to the 

page. The property pages are designed such that the top of each page contains a 

complete item description, where data for each item are specified, while the lower half of 

the page contains an overview of data specified for each item, presented in a single row.  

 

Selecting an object from the overview grid control, automatically changes the content of 

all edit fields on the upper part of the page in order to view all details specified on the 

actual data item. Parameters can be edited in both the detailed and the overview sections 

of each property page. 

 

Please note that the ‘Settings’ + ‘Network’ dialog provides a possibility of specifying 

settings for ‘Highlight object’. That is, the object being edited in the tabular view can be 

highlighted in the Graphical View by a user-defined symbol. 

 

5.5 Working with the Cross-section Editor 

River cross-section data comprises two data sets, the raw and the processed data. The 

raw data describes the physical shape of a cross-section using (x, z) co-ordinates, 

typically obtained from a river bed survey.  

 

The processed data is calculated from the raw data and contains corresponding values 

for level, cross-section area, flow width, hydraulic/resistance radius. The processed data 

table is directly applied in the computational module. 

 

Each cross-section is uniquely identified by the following three keys: 

 

• River name: String of any length.  

• Topo ID: String of any length. (topographical identification) 

• Chainage: Real number.  
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5.5.1 Raw data view 

The raw data view is the default view when a cross-section file is opened or created. An 

example of the cross-section raw data editor is shown in Figure 5.6. 

 

 
 
Figure 5.6 Cross-section, raw data editor 

 

The raw data section contains different ‘views’: 

 

• Tree View  

The tree view provides a list of all cross-sections in the cross-section file.  

 

The tree includes three levels, where the upper level defines the rivers names, the 

middle contains the Topo-ID(s) for the specific river and the lower provides a list of 

chainages of the cross-sections defined for the actual Topo-ID in the specific river. 

 

Selecting a cross-section from the tree by clicking the left mouse button will 

immediately update the tabular and graphical views, as all three views are fully 

integrated in order to present the data of the selected section automatically.  

 

Selecting a section chainage, river name or Topo-ID of a cross-section with the right 

mouse button opens a pop-up menu from which it is possible to make changes to the 

existing content of the cross-section file (e.g. insert, delete, copy and rename of 

sections, rivers and/or Topo-ID’s). 

 

• Tabular View  

The tabular view contains the raw cross-section data selected from the tree view.  

 

S- and Z-co-ordinates and relative resistance factors can manually be edited in the 

table. 

 

The resistance (relative resistance) in each row of the tabular view has a default 

value of 1, indicating a constant value of the roughness across the section. If the 

roughness is not constant across the entire section, e.g. on a flood plain or in a 

composite channel cross-section, the variation in roughness can be included by 

entering a relative resistance different from 1 for a part of the section. The resistance 
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is normally given relative to that of the main riverbed. A relative resistance greater 

than 1.0 indicates higher roughness and vice versa. 

 

The marker column lists the location of marker one, two and three each representing 

the river’s left bank, bed and right bank respectively. It is important to notice that only 

the part of a section, which lies between marker 1 and 3, is included when calculating 

the processed data. That is, parts of a section can be omitted from the computation 

by adjusting the location of markers (e.g. if a flood plain is included in the cross-

section data). 

 

The user can modify the location of markers. 

 

• Graphical View 

The graphical view displays the raw cross-section selected in the tree view.  

 

Depending on the current settings in the ‘Change Options’ page (opened from the 

Cross-section item in the Settings menu), the graphical view will overlay multiple 

cross-sections with previous selections displayed as a ‘watermark’.  

 

Selecting ‘clear’ in the local pop-up menu (right mouse button) clears the history 

graphical display. 

 

Apart from the river name, topo-ID and chainage, it is required to consider whether some 

of the other variables identifying each cross-section should be altered. These are: 

 

• Section type 

Section type can be defined as open (default), closed irregular, closed circular or 

closed rectangular. In case of a closed section the hydraulic radius using total area is 

always used, and MIKE 11 automatically introduces a Preissman slot when 

calculating the processed data table in order to allow the computation of pressurised 

flow. 

 

• Datum 

Datum adjustment will be added to all z-co-ordinates and all levels when calculating 

the processed data. In this way it is possible to link a local datum with a global datum 

or to correct for benchmark errors in the raw data. 

 

• Resistance  

In this section of the raw data window the user chooses to how to deal with bed 

resistance.  

 

Two choices have to be made: 

- Distribution (Transverse distribution). This defines description of the resistance 

across the cross section. There are three choices: 

 

Uniform: A single resistance number will be applied throughout the cross 

section. 

 

High/Low flow zones: Three resistance numbers are to be specified: 1) Left high 

flow resistance applying between marker 1 and 4. 2) Right high flow resistance 

applying between marker 5 and 3, and 3) Low flow resistance applying between 

marker 4 and 5. If marker 4 and 5 do not exist, the low flow resistance number 

will apply throughout. 
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Distributed: The resistance number is to be specified for each X,Z data set. 

 

- Type. There are the following choices for type of resistance number: 

 

Relative resistance: The resistance is given relative to the resistance number 

specified in the .hd11 file (HD parameter file). Resistance numbers higher than 

one always corresponds to higher physical resistance than specified in the 

.hd11 file (i.e. independent of the choice of resistance number type in the 

.hd11file). 

 

Manning’s n: The resistance number is specified as Manning’s n in the unit 

s/m(1/3). Resistance numbers specified in the .hd11 file do not apply. 

 

Manning’s M: The resistance number is specified as Manning’s M in the unit 

m(1/3)/s. Resistance numbers specified in the .hd11 file do not apply. 

 

Chezy number: The resistance number is specified as Chezy number in the unit 

m(1/2)/s. Resistance numbers specified in the .hd11 file do not apply. 

 

Other features of the Cross-section, raw data editor comprise: 

 

 

• Computation of processed data  

The computation of processed data is required after entering raw data, as the 

processed data tables must be used in the computation. 

 

Two options are available for computation of processed data: 

- The ‘Recompute all’ feature in the ‘Cross-sections’ menu in the Main menu bar 

re-computes the processed data for all cross-sections in the cross-section file in 

one operation. This is a very useful feature e.g. when a large number of new 

sections have been entered or many of the existing sections have been 

modified. 

- Press the ‘View processed data…’ button. This will compute the processed data 

for the selected cross-section and automatically open the processed data editor. 

This feature, however, is only active if the ‘Update processed data automatically’ 

check box is activated. 

 

• Update Markers 

The update of markers feature is a facility in MIKE 11 to automatically place the 

markers 1, 2 and 3 in case a cross-section has been modified or a new section 

introduced to the cross-section file. Markers will automatically (per default) be located 

at the first x, z co-ordinate (Marker 1), at the lowest z-value (Marker 2 at the bottom) 

and at the very last x,z co-ordinate (Marker 3).  

 

However, only the markers activated in the ‘Cross-section…’ (‘change options for…’) 

dialog will be automatically updated. 

 

Two options are available for updating the location of markers: 

- The ‘Update Raw data Markers’ in the ‘Edit properties for multiple Cross-

sections’ tool in which updates or marker location for all cross-sections in the 

cross-section file can be done in one operation. 

- Press the ‘Update Markers button’. This will update the markers for the selected 

cross-section. 
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5.5.2 Processed data view 

The Processed data view is opened by pressing the ‘View Processed Data…’ button in 

the Raw Data View 

 

The Processed data view also contains a tree view (as described above), a tabular and a 

graphical view, see Figure 5.7. The graphical display can be altered by selecting the 

desired parameter from the pop down list at the top of the page. 

 

 
 
Figure 5.7 Cross-section processed data editor view 

 

The tabular view contains processed data automatically calculated from the raw data. The 

processed data contains corresponding values of Water level, Cross-sectional area, 

Radius, Storage width and conveyance.  

 

Additional storage area (surface area) can also be specified as a function of the water 

level. 

 

If data has been altered, and it is required to keep the data unchanged in future, it is 

possible to protect the processed data for specific sections by activating the ‘Protect Data’ 

check box. 

 

Please note that the ‘Data Status’ group is not an editable field. The value of the data 

status is only an information to the user, whether the data has been edited or updated 

during the period where the processed data editor has been activated. 

 

Additional features of the processed data editor comprise: 

 

• Radius type 

The user must define which method to apply when calculating the hydraulic radius in 

the processed data table. Three methods are available; Resistance radius, Hydraulic 

radius using the total flow area and Hydraulic radius using the effective flow area. 

The effective flow area is the calculated area where the effect of altered relative 

resistance values is included. 
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• Modification of levels in processed data table 

If the number of levels and or the level values must be modified this is possible in the 

‘Levels for Processed data’ dialog, activated by pressing the ‘Levels…’ button. Select 

the level selection method, the min and max level and number of levels and press 

the ‘Recompute’ button to determine the new levels for the processed data. If the 

levels are satisfying, press the ‘OK’ button to close the Levels dialog.  

 

5.6 Working with the Boundary Editors 

Boundary conditions in MIKE 11 are defined by combined use of time series data 

prepared in the Time Series editor and specifications made on locations of boundary 

points and boundary types, etc. in the Boundary editor.  

 

That is, the ‘boundary editors’ comprise the Time series editor and the Boundary editor. 

Both editors are necessary to activate in order to specify a MIKE 11 boundary condition. 

 

5.6.1 Time series editor 

The appearance of the Time series editor differs if you create a new (blank) time series 

compared to opening an existing (dfs0) file.  

 

Creating a new time series requires specification of properties for the time series file, and 

the File Properties dialog is therefore opened in this case, cf. Figure 5.8.  

 

If you are opening an existing dfs0-file, the data are immediately presented in the Time 

series data dialog where data can be viewed and edited both in a graphic and a tabular 

view. In this case, if you wish to change the file already defined file properties, it is 

required to open the File Properties dialog from the graphical view. 

File Properties dialog 

 
Figure 5.8 Time Series Editor, File properties dialog 
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In the File Properties dialog, you must specify information on the time series axis and 

information on the items (series) which should be present in the specific dfs0-file. The axis 

information comprises: 

 

• axis type: Equidistant or non-equidistant intervals, calendar axis or time relative to a 

specified start-time or plot of X-Y data 

• start time (date-format follows the standard definition of Windows) 

• time step (given in days, hours, min, sec) 

• number of time steps (must always be larger than one!) 

 

Item information comprises: 

 

• Name of each time series item 

• Item type (e.g. water level, discharge, concentration etc.) 

• Item Unit (e.g. meter, m3/s, g/m3 etc.) 

• The ‘TS Type’ column is used to define different type of time series for different DHI 

software packages. However, MIKE 11 does not utilise the ‘TS Type’ settings in the 

simulations so this field can just be left unchanged from default 

• The ‘Min’, ‘Max’ and ‘Mean’ columns are not editable to the user. Values to these 

columns are automatically inserted based on the actual time series data 

• The  ,  and  buttons are used to modify the 

content of the Item information table. That is, Items can be appended to the bottom 

of the table, deleted from the table or inserted at a selected position by use of these 

buttons 

 

When you have concluded the definition of axis and item information, press the 

 button to activate the Time series data dialog. 
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Time Series Data dialog 

The Time Series Data dialog consists of two views, a tabular view and a graphical view 

(see Figure 5.9). 

 

 
 
Figure 5.9 Time series editor; Time Series Data dialog 

 

• Tabular view: 

- Presents the time series data in tabular form 

- Copy & Paste functions are available (e.g. copy and paste series from Excel) 

- The time format is determined from the selected default Windows format  

 

• Graphical view:  

- Data can be edited graphically by selecting one of the editing modes; Select, 

Move, Insert or Delete 

- When opening a time series file, all items contained in the file are plotted by 

default. The file title specified in the file properties dialog is used as a header on 

the graphical vies, while the item names are displayed in the upper left corner of 

the plot 

- To activate the pop-up menu as shown on Figure 5.9 place the cursor in the 

graphical view and press the right mouse button 

 

From the pop-up menu you have multiple options, like activation of zoom and 

refresh facilities, entrances to modify the appearance of the graphical view 

(enable or disable grid and legends, changing colour and styles etc.). 

 

Additionally, it is possible to open the File Properties dialog from the pop-up 

menu by selecting the ‘Properties…’ entry. Thereby, it is possible to alter 

previous property specifications of a specific file (e.g. if you want to add an 

additional item to the file, it must be done through the File Properties dialog!). 
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5.6.2 Boundary editor 

The boundary editor dialog is where boundary conditions are specified for hydrodynamic, 

advection-dispersion/water quality and sediment transport calculations.  

 

The definition of a Boundary condition requires the following actions to be performed - in 

the order as listed: 

 

1. Specify the location of the boundary point and the boundary description and type. 

 

Location is defined by the river name and the chainage. The boundary description 

(e.g. open, point source etc.) is selected from a combo box activated by pressing the 

right side of the edit field. The boundary type (e.g. water level, discharge, 

concentration etc.) is selected from the ‘Boundary Type’ combo-box. 

 

2. Use the  button to select a time series (dfs0). 

 

After defining the location of the boundary point, you must associate a time series to 

be applied at the boundary. The time series are kept in separate time series files 

(DFS0) and it is required to browse and select a time series file for each boundary 

definition.  

 

The  button is used to open the selected dfs0 file for a specific boundary 

condition (name of the selected file is listed in the ‘Time series File’ field). That is, the 

‘Edit’ button is a quick way to open a selected dfs0-file in the time series editor. 

 

Please note that if the ‘Time series file’ field is empty (no file has been selected), it will 

not be possible to use the ‘Edit’ button. Nothing happens if the button is activated. 

 

5.7 Working with Parameter File Editors 

The MIKE 11 parameter file editors are comprised of the Hydrodynamic, Advection-

Dispersion, Water Quality, Sediment Transport and Rainfall Runoff editors. The 

Parameter editors contains information on variables related to the selected type of 

computation, e.g. the HD Parameter Editor contains information on the bed resistance as 

a significant variable for the hydraulic computations. 

 

All parameter editors are designed as dialogs containing a number of property pages in 

which specific data can be entered. Clicking the corresponding ‘tab’ in the editor dialog 

will activate a property page.  

 

5.7.1 HD parameter editor 

To run a hydrodynamic computation it is required to create a HD Parameter file. The HD 

parameter editor offers a possibility of specifying user-defined values for a number of 

variables used during the hydrodynamic computation. The HD parameter editor is shown 

in Figure 5.10. 
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Figure 5.10  HD Parameter Editor 

 

Initial 

Before starting a computation, the user must select how the initial conditions will be 

specified. MIKE 11 can automatically compute a steady-state profile in the river or the 

channel network compatible with the given boundary conditions at the specific 

computation start time in the simulation editor. Alternatively, the initial conditions may be 

obtained either from an existing result file (a so-called ‘Hotstart’) or from manually 

specified initial conditions of corresponding values for Water levels and Discharges in the 

entire network at the start time of the computation. 

 

A global initial condition (water level and discharge) can be entered. This global condition 

is applied throughout the model, unless otherwise specified. It is possible to specify a 

number of river reaches or channel reaches; ‘Local values’, where initial values of water 

level and discharge different from the global values are to be applied. The values entered 

for the initial water levels can also be interpreted as water depths by using the radio 

bottom. 

 

Figure 5.10 shows an example of such a specification. A global water level of 2.5 m and a 

global discharge of 12 m3/s have been specified. In the branch ‘RIVER 1’ between 

chainage 0 m and 2500 m, alternative conditions are given. These indicate that the initial 
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water level varies linearly between 2.3 m and 2.5 m and the discharge between 10 m3/s 

and 12 m3/s in the specified river reach. 

 

Wind 

If the user wishes to include Wind shear stress, it is required that a time variable boundary 

condition for Wind Field is included in the simulation. The Wind Field boundary condition 

consists of specifications for Wind direction (towards North) and the Wind velocity.  

 

In the Wind page of the HD Parameter dialog, the user can activate the usage of Wind 

field in the computation by activating the ‘Include Wind’ check box. 

 

The time varying boundary condition defines the wind field, but local variations must often 

be taken into consideration. This can be done by specifying a topographic wind factor 

(topo factor), and if a topo factor is defined for a particular reach, the wind velocity used in 

the computations will be applied as the velocity multiplied by the topo factor.  

 

Bed Resistance 

The resistance number must be specified in this page. The resistance number can have 

one of three different forms, of which Manning’s M is default: 

• Manning’s n 

• Manning’s M  (M = 1/n) 

• Chezy number 

 

Two approaches exist: Uniform Section and Tripple Zone. When the Uniform Section 

approach is selected the specified resistance number will be valid all over the section. If 

the Tripple Zone approach is selected the cross sections are divided into three zones and 

a resistance number must be specified for each zone. 

 

The resistance number specified on this menu is multiplied by the resistance factor 

specified for a given cross-section (and water level) in the processed data of the Cross-

section file during computations. 

 

Global and local values for the resistance number can be defined. During a calibration 

exercise, typically, the resistance number is the most significant variable to adjust, and 

therefore, you will typically need to specify (a number of) local values to account for local 

variations in the topography, vegetation etc. 

 

Bed Resistance Toolbox 

The bed resistance toolbox offers a possibility to make the program calculate the bed 

resistance as a function of the hydraulic parameters during the computation by applying a 

Bed Resistance Equation. The equations are designed to simulate the influence of 

vegetation on the resistance during varying flow conditions. Details on the equations can 

be found in the User Guide. 

 

Wave Approx 

It is possible to specify which wave approximation should be used in the computation, viz 

Kinematic, Diffusive or one of two fully dynamic wave approximations.  

 

Default is the dynamic wave. 
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Default Values 

In this page it is possible to alter the value for a number of parameters connected to the 

hydrodynamic computations. 

 

Parameters should not be altered, unless the user is familiar with the effect on the results. 

A more detailed explanation of the various parameters is given in the MIKE 11 On-line 

help system and MIKE 11 Reference manual. 

 

Quasi Steady 

A number of Quasi-Steady Control parameters connected with the Quasi steady 

computations are entered in this page. Detailed description can be found in the MIKE 11 

On-line Help and MIKE 11 Reference manual.  

 

Time Series Output 

On this property page request is made for time series output files to be generated during 

the simulation. This output is in addition to the regular and the additional .res11 output file. 

Time series output can be saved in .dfs0 or ASCII files. 

 

Maps 

On this property page request is made for that MIKE 11 produces two dimensional maps 

based on the one-dimensional simulations. The maps are constructed through 

interpolation in space of the grid point results. Thus the maps constructed in this way 

should be viewed as a two dimensional interpretation of results from a one -dimensional 

model 

 

Reach Lengths 

This can only be used in connection with Quasi Steady simulations, see above. Detailed 

description can be found in the MIKE 11 On-line Help and MIKE 11 User manual. 

 

Add. Output 

Additional output can be produced upon request by the user. This extra facility is available 

as a supplement to the hydrodynamic result file. The additional output is stored in a file 

with a similar name as the HD result-file name. Only difference is that an additional string 

‘HDADD’ is added to the filename of the HD result-file name.  

 

Example: If the HD result filename is ‘HDRES1.RES11’, the name of the additional output 

file would be; ‘HDRES1HDADD.RES11’ 

 

To activate the additional output, the user must activate the check-box in front of the item 

to save to the additional output result-file. 

 

Flood Plain Resistance 

Normally, the resistance numbers on flood plains are included through editing the relative 

resistance factors above ‘Level of Divide’ in the Cross-section editor, Raw data 

specifications. Hence, it is possible to reduce the effective flow area as a function of the 
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water level. Another possibility of changing flood plain resistance numbers is to edit the 

Resistance Factor in the Processed Data in the cross-section editor.  

 

However, if the modelling task does not require a water level dependent resistance on 

flood plains, an overall Flood Plain Resistance number can be specified in this page. 

Please note that flood plain resistance numbers are only applied above the ‘Level of 

Divide’. Hence, it is required also to modify the cross-section data in order to activate this 

feature. 

 

A global resistance number on the flood plains in the model can be specified. This is 

applied on all flood plains unless local values are specified. Local specified values are 

linearly interpolated. Giving the value ‘-99’ as resistance number indicates that the flood 

plain resistance number should be calculated from the raw data in the cross-section file. 

 

User Def. Marks 

The User Defined Markers page offers a possibility for the user to define items in the 

modelling area, which they would like to present on a longitudinal profile from MIKE View, 

(e.g. gauging stations, bridges etc.). Markers can be defined as single points at a specific 

chainage or as a marker with a certain length between two chainages in the same river 

stretch. 

 

Encroachment 

The Encroachment module of MIKE 11 can be used to make analysis of the effect on 

making encroachment on floodplains. The necessary information is specified on this 

property page. Details are given in the User Guide. 

 

Heat Balance 

It is possible to include detailed descriptions of the heat exchange between the water and 

the atmosphere in MIKE 11. The necessary data must be entered here. Details are given 

in the User Guide. 

 

Stratification 

When one or more of the branches in the MIKE 11 set up have been selected as 

‘Stratified’ the data necessary to run the stratified model must be entered here. Please 

see the User Guide for more details. 

 

5.7.2 AD parameter editor 

The AD Parameter file is required in order to run an Advection-Dispersion (and a Water 

Quality) simulation. The AD parameter file contains information on each of the pollutant 

components included in the simulation. The AD parameter editor is shown in Figure 5.11. 
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Figure 5.11 AD Parameter Editor 

 

Components 

In this page, the name, unit and component type must be specified for each of the 

substances (components) to be included in the Advection-Dispersion computations.  

 

Unit and component type (Normal, Single Layer Cohesive, Multi Layer cohesive or Non-

cohesive) must be selected from the corresponding combo-box. To activate the combo-

box activate e.g. the unit field and press the ‘down-arrow’ appearing after the field has 

been selected. 

 

The ‘Fill WQ Components’ button can be used to automatically define the WQ model to 

be used in a WQ computation. After selection of the WQ-model type and level, the 

component table is automatically filled with the component names, units and order of 

components. The order of components is very important if you are performing a WQ-

simulation. 

 

Dispersion 

The dispersion coefficient and factors are specified in this page. Dispersion can be 

specified as a function of the flow velocity calculated by the following expression: 

 

D = f*Vex,  

 

where: 

D  is the dispersion coefficient  

V  is the flow velocity  

f  is the dispersion factor 

ex is a dimensionless exponent 
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Minimum and maximum dispersion coefficient values are specified to limit the range over 

which the calculated dispersion coefficient may vary. 

 

Init. Cond. 

Initial conditions, i.e. initial concentrations of each component are specified in this page. 

 

In the Component column, select from a combo-box the component for which you wish to 

specify initial conditions. The combo-box in the component column lists the components 

specified in the ‘Components’ page and a specific component can be selected from the 

list. 

 

In the Concentration column specify the initial concentration of the component in the unit 

selected in the Components page. 

 

Both global and local initial conditions can be specified for the same component. If you 

wish to specify local variations in initial conditions de-activate the ‘Global’ check-box and 

specify the location (river name and chainage) of the initial condition for the specific 

component. The global value will be used everywhere except in those reaches where 

additional local values have been specified. If no value is entered for a component, a 

global concentration of zero will be applied automatically. 

 

Decay 

It is possible to specify one or more non conservative components, i.e. the concentration 

is assumed to decay according to the first order expression: 

 

dC/dT = K*C 

 

where: 

K is the decay coefficient  

C  is the concentration  

 

If the data entered are used in connection with a water quality computation, the user 

should not specify the decay coefficients, as the special water quality model computes 

these coefficients. 

 

Boundary 

This property page is not in use anymore. The information previously entered here should 

now be entered in the boundary editor. The property page is visible so set ups made in 

previous releases can be inspected and converted properly when updating to the present 

version. 

 

Cohesive ST 

Data used for the cohesive sediment transport models are entered on this page. When 

using the cohesive sediment transport models (either the simple or the advanced) all 

components specified in the AD editor must be defined as ‘Single layer cohesive’ or ‘Multi 

layer cohesive’ in the Components dialog.  
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The cohesive sediment transport parameters can only be accessed when a component 

type on the ‘ Components’ page is defined as either single or multi layered. Global and 

local parameter values can be specified as required. 

 

Sediment Layers 

Initial conditions for the sediment layers are defined on the Sediment Layers page. 

Selection combo-boxes are available for the component types ‘Single cohesive’, ‘Multi 

cohesive’ or ‘Non cohesive’. 

 

When the single layer model is used only one sediment layer is displayed. When a multi-

layer cohesive model is applied, three layers, upper, middle and lower are displayed. 

Parameters must be specified for each layer on three separate rows. 

 

Non-Cohesive ST 

This page contains input parameters for Non-Cohesive components. A non-cohesive 

component is defined using the data section at the bottom of the page. 

 

Additional Output 

The additional output page contains check-boxes, which can be used to store internal 

model parameters in an additional AD result file. The name of the additional AD result file 

is similar to the AD result-file name. Only difference is that an additional string ‘ADADD’ is 

added to the filename of the AD result-file name. 

 

Example: If the AD result filename is ‘ADRES1.RES11’, the name of the additional output 

file would be; ‘ADRES1ADADD.RES11’ 

 

5.7.3 ST parameter editor 

To run a non-cohesive sediment transport simulation it is required to give specifications 

on e.g. sediment grain size (grain diameters) to calculate the correct transport and 

eventual morphological changes.  

 

MIKE 11 permits the computation of non-cohesive sediment transport capacities together 

with corresponding accumulated erosion/sedimentation rates, using several different 

transport and calculation models.  

 

The MIKE 11 sediment transport model operates in two ‘modes’: 

 

• Explicit sediment transport model 

In the explicit model the sediment transport computations are based either on the 

results from an existing HD result file or from a HD computation made in parallel 

using characteristic transport parameters. Sediment transport is calculated in time 

and space as an explicit function of the hydrodynamic parameters (i.e. discharge, 

water levels etc.), previously calculated. There is no feedback from the sediment 

transport computations to the hydrodynamics. 

 

• Morphological sediment transport model  

The sediment transport computations are made in parallel with the HD computation. 

The sediment transport is calculated in time and space as an explicit function of the 
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corresponding values of the HD parameters calculated in tandem. The resistance 

number may be updated and the bottom level is updated so that changes in flow 

resistance and hydraulic geometry dye to the sediment transport can be included in 

the HD computations. 

 

This model requires sediment or bottom level boundary conditions at all inflow 

boundaries. 

 

Variables for the sediment transport model are specified in the ST parameter editor, see 

Figure 5.12. 

 

 
 
Figure 5.12:  ST Parameter Editor 

 

Sediment Grain Diameter 

Sediment Grain diameter and standard deviation to be used in the ST computation are 

specified in this page. Grain size and standard deviation may be specified as being 

applicable globally and locally. 
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Transport Model 

Selection of transport model to use and specification of parameters and constants for the 

specific transport model must be given in this page.  

 

The transport model is selected by the ‘Model Type’ combo-box. 

 

A detailed description of the parameters of this page can be found in the MIKE 11 On-line 

help. One variable to mention here though, is the check-box for ‘Calculation of Bottom 

Level’. This check-box differs between the two sediment transport modes; explicit and 

morphological such that if the check-box is activated, MIKE 11 will operate in a 

morphological mode and therefore, the ST computation must be made in parallel with a 

HD computation. 

 

Calibration Factors  

The factors; ‘Factor1’ and ‘Factor2’ can be applied to the calculated transport rates as 

correction factors. Bed load transport is multiplied with ‘Factor1’ and Suspended load 

transport is multiplied with ‘Factor2’.  

 

If the sediment transport is calculated as total load ‘Factor1’ is applied. These factors can 

be applied globally and locally. 

 

Data for Graded ST  

Input data for the simulation of graded sediment transport and sediment sorting are 

specified in this page.  

 

The bed material is represented by two layers, an active layer overlying an inactive, 

passive layer. Each layer is divided into an equal number of fractions (or classes) 

specified by the user. A mean grain size (mm) for each fraction and the percentage 

distribution for both the active and the passive layer must be specified.  

 

The fraction mean grain sizes are global but the initial percentage size distributions may 

be specified globally or locally.  

 

The sum of the initial percentage distributions for both the active and the passive layers 

must equal 100%. 

 

Shielding of particles can be included by activating the ‘Shielding of particles’ check-box, 

and additionally, the user can select the percentage contribution and transport rate of 

each fraction to be saved to the ST result file by activating the corresponding check-box. 

 

Preset distribution of Sediment in nodes 

The default distribution of sediment at a node is carried out according to the ration of flow 

discharges. A user-defined distribution can be specified in this menu by giving the 

distribution coefficients and exponents (K and n variables in the distribution relationship - 

please refer to the MIKE 11 On-line help for more detailed information). 
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Passive Branches 

Branches, in which sediment transport should not be calculated, are specified by giving 

the river name as well as the upstream and the downstream chainage.  

Sediment can be transported into a passive branch, but no sediment can be transported 

out of a passive branch. 

 

Initial dune dimension 

Only used together with the Engelund-Fredsøe transport model. This property page is 

used for specification of the initial dune length and height. 

 

Non Scouring Bed Level 

This property page is used to define a level – both globally and/or locally – at which the 

bed is no longer erodible. It can also be used to define the thickness of the active layer 

used in the Graded Sediment Model. 

 

5.7.4 WQ simulation parameters (MIKE ECO Lab) 

Water quality simulations in MIKE 11 is undertaken by use of the so-called MIKE 

ECO Lab system using pre- or user-defined ‘Templates’ describing the actual processes 

to investigate. A number of pre-defined MIKE ECO Lab templates for the more standard 

or common water quality aspects are developed by DHI and enclosed in the installation 

package. These include simple BOD-DO relations to Eutrophication and Heavy Metals 

etc. For more details on Templates available and their specific content, please refer to the 

MIKE 11 User Manual on Water Quality modelling 

 

To run a water quality simulation, the user must define WQ parameters in a separate 

parameter file with the extension ’.ECOLab11’, which contains a reference to a selected 

MIKE ECO Lab model template (where all equations and processes are defined) and the 

user defined values of specific parameters involved in the selected water quality model.  

 

Figure 5.13 presents the front page of the WQ parameter editor in which the MIKE 

ECO Lab Template model file should be selected. 
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Figure 5.13:  MIKE 11 WQ simulation file (.ECOLab11)  

 

The contents of the ‘.ECOLab11’ file should be saved and the name of the file should be 

specified on the Input page of the simulation editor. 
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6 Setting Up a Simulation 

6.1 Using the Simulation Editor 

The Simulation Editor combines all information necessary for MIKE 11 to perform a 

simulation. This information comprises type of model to run, name and location of input 

data files, simulation period, time step etc. and name of result files.  

 

 
 
Figure 6.1 Simulation Editor of MIKE 11 

 

The Simulation editor contains 5 property pages in which data must be specified. 

 

Models property page 

Select the models (HD, AD, ST, WQ etc.) to be included by activating the checkbox for 

the specific simulation model, 
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Additionally, you must select the simulation mode (Unsteady or Quasi steady simulation). 

If an encroachment simulation is to be made the encroachment checkbox must be 

checked. 

 

Input property page 

Specify the location of input files to be used in the simulation. The type of input files 

necessary for the simulation is identified by the colour of the edit fields. If the field is white 

the field can be edited and a file must be selected. If the field is grey (‘dimmed’) it is a 

non-editable field and the specific input file is not required for the simulation. One 

exception though, is the edit field; ‘RR Results  (*.RES11)’ which is used to specify an 

input file from the Rainfall Runoff simulation only. If you do not require any runoff input 

from a Rainfall Runoff simulation, this field should just be left blank. 

 

Input files can be located in any directory on the disk. Use the  button to browse a 

specific input file in a file selection box.  

If a filename has been specified in a filename field, you can use the  button to 

open the file in its corresponding editor  

 

Simulation property page 

In the Simulation property page, information on the simulation period, time step and type 

of initial condition must be specified. Further the user can select if a fixed time step, a 

tabulated time step or an adaptive time step should be used or  

 

 
 

There are two ways of specifying the simulation period: 

 

1. Specify manually the simulation start and end time respectively. The date-format to 

be used for the simulation start and end time must be the same as Windows utilises 

(e.g. yyyy-mm-dd  hh-mm-ss) 

 

2. Press the  button to let MIKE 11 automatically determine the minimum 

and maximum date and hour where all time series (defined in the boundary file) have 

common periods. The date and hour for start and end time respectively are then 

automatically inserted in the field. 

 

If no common period exists for the time series defined in the boundary files, nothing 

happens and the value in the Start and End date fields are not modified. 

 

After specifying the simulation period, the simulation time step must be defined. Specify a 

value for the time step and select the unit (days, hour, min, sec). 
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The Time Step multiplier for Rainfall Runoff (RR) and Sediment Transport (ST) modules 

can also be specified in case one of these models is selected.  

The Time step multipliers are used to adjust the time step applied for these models. E.g. 

in ST-simulations it will often be necessary to run the Hydrodynamic model using a much 

smaller time step than required in the ST model. That is, the time step used in the RR 

and/or ST model is therefore the multiplier-value multiplied the simulation time step. 

 

Finally, specify the type of initial condition to use (steady state, hotstart, parameter file) 

 

 

Type of Initial conditions: 

 

• Steady State 

MIKE 11 calculates automatically a steady state profile for the entire model 

• Hotstart 

Initial conditions are read from results of previous simulation (define a result-file) 

• Parameter File 

Initial conditions are read from Input Parameter file (e.g. HD Parameter file) 

 

Results property page 

Specify the filename for results from the simulation. 

 

Storing frequency can be used to decrease the size of result-files by reducing the number 

of time steps saved. (e.g. Storing frequency specified as 10 means that results are saved 

in the result-file for every 10 time-step only).  

 

Start property page 

In the Start property page you will find two validation groups. One group informing on the 

status of the simulation (are all input files required for the simulation specified? do the 

time series files used for boundary conditions have a common period – and is the 

simulation period within this period?).  

 

If a problem exists, a red light symbol is displayed in the validation group and it will not be 

possible to start the simulation. If all input files are satisfactory, a green light symbol is 

displayed and pressing the Start button starts the simulation. 

 

6.2 Simulation Editor File – also a Simulation-Log 

All information specified in the Simulation editor are saved in a Simulation editor file 

(*.sim11). The sim11 file is – as most of the other editor files in MIKE 11 – an ASCII text-

file. It is therefore possible to view the content of these input files in any word processing 

program (like Notepad, Works, Word, etc.). 

 

Occasionally, it is required to go back in time and investigate results and/or input from 

previous projects, and it is therefore necessary to keep a log of the simulations performed 

(input files used, time step, etc.). If you are running several simulations (e.g. using 

different input files or simulation periods) it is therefore advisable to save the input for 

each simulation in a separate Simulation editor file.  
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Saving each simulation in separate simulation file you do not have to keep an additional, 

separate log of each individual simulation. Simply specify a name for the simulation files, 

which identifies the content of the file and eventually the purpose of the simulation. 
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7 MIKE 11 Tutorial 

7.1 What Will I Learn? 

Following the instructions given in this tutorial users with no experience with MIKE 11, will 

be guided through the set-up of a simple river network, cross-sections, boundary 

conditions, HD parameters and simulation parameters as well as presentation of 

simulation results. 

 

Contents 

1. Network Editor. Basic Facilities 

2. Cross-section Editor  

3. Boundary and Time Series Editor  

4. HD Parameter Editor  

5. Running a Simulation  

6. MIKE View 

 

7.2 Network Editor – Basic Facilities 

The aim of this exercise is to introduce the basic facilities of the network editor, i.e. how a 

system of branches is defined and connected. 

 

Start MIKE 11 to produce the MIKE Zero base screen. The MIKE 11 river network file is 

created here using the File menu by selecting New from the menu and choosing MIKE 11 

and River Network. A MIKE 11 river network screen is created with default area co-

ordinates. The size and position of both the MIKE 11 window and the river network 

window may be changed to allow for easier viewing of river branches defined later in this 

tutorial. 

 

Defining a branch 

Defining and editing a river network is mainly undertaken using the river network toolbar: 

 

 
 
Figure 7.1 Network toolbar 

 

More details on the functionality of each of the buttons can be found in the help system 

under the topic ‘Graphical Editing Toolbar’. 

 

To define the branch shown below you should select the  button in the toolbar and 

define the branch by clicking the left mouse button once at the position of each river point. 

Start at the upstream end of the river branch (which is assumed here, to be in the upper 

part of the window). The last point in the branch should be defined by a double click. 
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Figure 7.2 Plan plot, one digitised branch 

 

Chainage in points 

Once a branch is defined the chainage of each point is calculated automatically based on 

the distance between the digitised points. The default chainage of the first point in a 

branch is zero. See the topic ‘Chainages in Points’ in the help system for more details. 

The calculated chainages may not be optimal and the user may wish to set the chainage 

manually. This can be done in two ways:  

 

Option 1) 

Click with the right mouse button at the point for which the chainage is to be changed and 

a Pop-Up Menu will be displayed as shown below. See the topic Pop-Up Menu in the help 

system for more details.  
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Figure 7.3 Network editor, Right mouse Pop-up menu 

 

When selecting the item Point Properties in the Pop-Up Menu the following dialog will 

show up. The user can then set the chainage manually by setting the chainage type to 

User Defined and then entering the desired chainage value. When clicking the OK button 

the chainages in all remaining points within the river branch will be recalculated 

accordingly. 

 

 
 
Figure 7.4 Point properties dialog 
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Option 2) 

Select the item Tabular View in the View menu and change to the Points page of the 

tabular view as shown below: 

 

 
 
Figure 7.5 Graphical and Tabular view, Network editor 

 

This page contains information about each point and allows the user to change the 

chainage type and value. The graphical and tabular views are linked such that the 

highlighted points in the each of the views are always the same. 

 

In the above river system the chainage type should be set to user defined for the first and 

last points of the river branch with the chainage assumed to be 0 and 100000, 

respectively. 

 

Display of objects 

When a branch is defined a label indicating the name and chainage from upstream to 

downstream may be displayed adjacent to the branch. The display of these labels, as well 

as any other object shown in the graphical view of the river network editor, can be 

controlled through the Network Settings dialog shown below. This dialog is activated by 

selecting the item Network in the Settings menu. See the topic ‘Graphical Settings 

Property Page’ in the help system for more details. 
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Figure 7.6 Network settings dialog 

 

Defining and connecting additional branches 

The  tool can be used to create the points and branch in one operation. Alternatively 

the points can be defined in one operation and the branch in another by using the  

tool followed by one of the tools  or .  

 

In Figure 7.7, eight points in a tributary have been digitised using the  tool.  

 

Note that the points appear in the list of points in the tabular view, but there is yet no 

information on which branch the points belongs to. 
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Figure 7.7 One branch defined, second branch digitised 

 

To connect the eight points the tool  or  can be used (start at the left most point) 

and when the connection is done the screen should look similar to the following. 

 

 
 
Figure 7.8 Two branches defined with user-defined chainages in up- and downstream points 
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Note that the branch information is now available in the list of points in the tabular view. 

The chainage type should be set to user defined in the first and last point and the 

chainages set to 12000 and 27000, respectively. 

 

 

Before connecting the two branches each should be given identification names. This is 

done on the branch page of the tabular view where the river names are changed to ‘Main’ 

and ‘Trib’ as shown below. For both rivers the Topo ID should be set to 1997. 

 

 
 
Figure 7.9 River Names defined as ‘Main’ and ‘Trib’ 

 

To connect the tributary to the main river the  button should be used. Point at the 

downstream end of the tributary and while clicking and holding the left mouse button 

move the cursor to the point on the main branch you wish to connect and then release the 

mouse button. The connection is indicated by a line as shown below: 

 

 
 
Figure 7.10 Connection of river branches 

 

The contents of the network editor should now be saved by selecting the Save item in the 

File menu. 
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7.3 Cross-section Editor 

The aim of this exercise is to show how cross-sections are created and then to establish 

links between the network editor, the cross-section editor and other editors.  

 

The latter requires the use of the simulation editor, which in general serves two purposes: 

 

1. It allows the user to specify a range of simulation parameters such as file names and 

time step and it allows a simulation to be started. 

 

2. It enables the network editor to communicate with other editors. This communication 

could for instance be to receive from the cross-section editor a list of locations with 

cross-sections. Another example is when the network editor instructs the cross-

section editor to insert a cross-section at a specific location. Such communication 

requires that a file name for each of the editors is specified. This takes place in the 

Input Property Page of the simulation editor.  

 

In the simulation editor file names for both the network and cross-section files are 

required, and to do so an empty cross-section file needs to be created. This is done by 

selecting New on the File menu followed by Save and then Close. Similarly an empty 

simulation file has to be created and saved. 

 

The simulation file is loaded and on the Input page of the simulation file editor the name of 

the network file and the empty cross-section file is specified using the  button. The 

network file can now be accessed using the Edit button on the simulation file menu. 

 

 
 
Figure 7.11 Simulation editor after selection of network and cross section file 
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Cross-section is required to be inserted at upstream and downstream end of both 

branches. This is done using the right-click Pop-Up Menu. Point at the upstream end of 

the Main branch and click at the right mouse button and select Insert, Network, Cross-

section, as shown below: 

 

 
 
Figure 7.12 Using the Right mouse pop-up menu to insert new cross-section 

 

The cross-section editor will appear and the data for the cross-section can be entered as 

shown. The name of the branch and the chainage will be automatically transferred to the 

cross-section editor. Modify the Z-value to 10.0 for Marker 1 and Marker 3 in the table. 

 

 
 
Figure 7.13 Cross-section editor, raw data editor 

 

Once the raw data has been entered the button View Processed Data should be pressed 

to display the processed data tables.  

 

The processed data will be calculated when the Recompute button is pressed. 
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Figure 7.14 Cross-section editor, Processed data editor 

 

Similar cross-sections should now be inserted at the downstream end of Main branch and 

at both ends of Trib branches. Modify here the Z-values for Marker 1 and Marker 3 as 

well.  

 

The cross-section file is now saved and closed. 

 

7.4 Boundary and Time Series Editor 

The aim of this exercise is to create time series and boundary conditions. 

 

The boundary condition at the upstream ends is zero discharge and at the downstream 

end the water level varies between 5 and 6 meters. First the file containing the variation in 

time of the water level and the discharge must be defined and to do so a new time series 

file is created from the New item on the File menu. The properties for the file should be 

entered as follows: 
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Figure 7.15 Time series ‘File Properties’ dialog 

 

The format of the start time follows the standard windows format, which depending on the 

configuration of your PC might be different from the above shown. 

 

Once the OK button is pressed the time variation of the water level can be entered as 

follows. The discharge values are to be kept as zeroes. 

 

 
  
Figure 7.16: Time series editor, two items included in time series file 
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The content of the time series editor should be saved and closed using the File menu. 

 

An empty boundary file must now be created, similar to the way in which an empty cross-

section file was created earlier in this tutorial. The name of the file should be specified on 

the Input page of the simulation editor. 

 

The location and type of boundaries can now be specified through the network editor 

where the Pop-Up Menu is used to insert the boundary at the downstream end of Main. 

The boundary editor now pops up and the location of the boundary is automatically 

transferred as shown below: 

 

 
 
Figure 7.17 Boundary editor, defining downstream boundary condition 

 

The time series file and item must be selected using the Browse button (…). This will 

open the file and item selector as shown in Figure 7.18. 
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Figure 7.18 Time series, Item selector dialog. ‘Green button Items’ can be selected 

 

In a similar manner the discharge boundaries at the upstream of both Main and Trib must 

be inserted and the correct file and item has to be selected. The boundary editor should 

now have the following content: 

 

 
 
Figure 7.19: Boundary conditions for the tutorial set-up 
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The content of the boundary editor can now be saved and the editor closed using the File 

menu. 

 

7.5 HD Parameter Editor 

The final data required to run a simulation is the HD parameters, and to define those, a 

HD Parameter File is created through the File menu. The only parameter to be changed 

from the default values in this tutorial are the initial water levels. This is specified on the 

left most page of the HD Parameter file as shown. The initial water level should be 5 

metres. 

 

 
 
Figure 7.20 HD Parameter file, Initial conditions 

 

The contents of the file should be saved and the name of the file should be specified on 

the input page of the simulation editor. 

 

7.6 Running the Simulation 

In order to run the simulation the pages of the simulation editor must be set-up as shown 

in the following diagrams. 
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Figure 7.21 Simulation editor, Models selection page 

 

 
 
Figure 7.22 Simulation editor, selection of input files for simulation 
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Figure 7.23 Simulation period, time step and initial condition selection for simulation 

 

 
 
Figure 7.24 Specify the result-file name 
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Figure 7.25 Ready to start the simulation – press the ‘Start’ button 

 

When the start button is pressed the simulation will start and the progress of the 

simulation will be shown in the lower part of the simulation editor:  

 

 
 
Figure 7.26 Simulation progress dialog 

 

Once the simulation is complete the window will disappear and the results of the 

simulation can be inspected using MIKE View. 
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8 MIKE View Tutorial 

8.1 MIKE View in General 

The MIKE View program has been adopted as the result viewer for MIKE 11. In the 

current release MIKE View has not been integrated into the MIKE 11 structure and 

therefore, must be started as a stand-alone program.  

 

MIKE View offers a variety of functions and features for viewing and analysing simulation 

results produced by the MIKE 11 system. The main presentation features comprise: 

 

• Colour plan plot of the river network 

• Longitudinal profiles 

• Time series plot (Several events can be presented on the same plot).  

• Animation of water level in cross-sections 

• Results from several result-files can be included for comparison. 

• Plot of Q-h relations  

• Animation of user-specified result items (plan plot, longitudinal profiles and time 

series). 

• Zoom facility in all windows 

• Scanned images of background maps can be loaded 

• Hard copy of all plots 

 

One of the most interesting options in MIKE View is the ‘show synchronised’ feature. This 

feature allows the user to play back the results of one or more simulations while viewing 

the results from several types of display windows, all fully synchronised. This option 

opens the possibilities of: 

 

• Viewing a plan view (e.g. with water levels or concentrations) together with a 

longitudinal section, one or more time series and a Q-h relation plot, for a single 

simulation fully synchronised in time. 

• Viewing two sets of plan views, time series etc. for two alternative simulations, shown 

together and fully synchronised. 

• Viewing synchronised output from MIKE 11 and the DHI Urban Sewer modelling 

product; MOUSE, showing Combined Sewer Overflow (CSO’s) from MOUSE which 

pass into the river, the resulting hydrodynamic impacts and the effects on river Water 

Quality parameters. 

More detailed information on the use of MIKE View can be found in the ‘MIKE View User 

Manual’ and the integrated on-line Help available within MIKE View. Descriptions and 

useful information on the dialogs and other available features are well described within 

the on-help system. 
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8.2 What Will I Learn in the MIKE View Tutorial? 

This tutorial will guide you step by step through the basic features of MIKE View. The 

result file included in this tutorial is a MIKE 11 result file (originates from the Vida 

demonstration example enclosed with the MIKE 11 Installation), but the main principles 

shown here are also applicable for the viewing of MOUSE result files. MOUSE is the DHI 

system for modelling of Urban Sewer Systems. 

 

When going through the tutorial, you will get the feeling of the most important features of 

MIKE View. With the help of the MIKE View Manual and the MIKE View online Help you 

should be able to get optimal results in your work with MIKE View.  

 

8.3 Before You Begin 

You can work with this Tutorial without any prior experience with MIKE View. However, at 

this stage MIKE View should be properly installed and you should be able to start the 

program, otherwise refer to the MIKE View User Manual, before you begin. 

 

Please note that even though MIKE View is a user-friendly presentation tool for urban 

drainage systems, rivers and canal networks, the successful usage of the program 

requires some basic understanding of the respective hydraulic engineering areas. 

 

A copy of the result file used by this tutorial is automatically installed on your computer. It 

is located in the ‘Vida’ directory under ‘Examples\Mike_11’. 

 

8.4 About MIKE 11 and MOUSE Result Files 

MIKE 11 and MOUSE produce several types of result files which all have one thing in 

common: they contain time series for various variables in the system.  

 

The result files from the two types of models are distinguished by the file extension. Each 

result file type can contain only certain types of time series, which depends on the actual 

process treated by the model (e.g. runoff, sewer network flow, river flow, pollution 

transport, etc.). 

 

From the MIKE View point of view, the result files are hierarchically divided in two groups: 

 

• Files including the network geographical information: 

- MIKE 11 DSF result file (*.RES11),  

- MOUSE HD result file (PRF) 

- MIKE 11 HD result file (RRF), MIKE 11 version 3.2 and previous versions – and 

not to be confused with MOUSE Runoff result files which also has the extension 

RRF but cannot be opened, only added 

• Files without the network geographical files, e.g. Advection-Dispersion result file 

generated with MIKE 11 version 3.2 or previous releases (TRF). 

 

The files from the first group establish a platform for the result viewing in MIKE View, 

since MIKE View is a map-based presentation tool. These files can be loaded into MIKE 

View through the <Open> function. 
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The files from the second group can be loaded into MIKE View with the <Add> function, 

being associated with the relevant (already loaded) file from the first group. Of course, the 

added file has to be fully consistent with its associated MIKE 11 or MOUSE file. 

 

8.5 What Are We Going to View 

The river network related to the result file in this tutorial consists of the following elements: 

 

• 10 River branches including one main river and several tributaries feeding the main 

stream, 

• 8 hydraulic structures of which 7 are regular broad-crested weirs and one is a 

controllable structure with a movable gate controlled by the water-level conditions in 

a gauging point upstream of the movable gate. 

We are going to examine the details of the network layout throughout the exercise. 

 

8.6 Loading Results 

Start MIKE View by choosing ‘MIKE View’ in the ‘MIKE 11’ program group.  

 

At start-up, MIKE View opens the File Open view. This facility makes it possible to 

navigate through the accessible drives, and you can easily find the data directory with 

your result file. 

 

Examine the possible choices of result file types by clicking on the ‘Files of Type’ field. 

Select the ‘MIKE 11 DFS Files (*.Res11)’ option, i.e. the MIKE 11 Result file. 

 

All DFS11-files available in the Vida directory are listed. Select the ‘VIDA96-3.Res11’ file. 

 

Some result files can be rather large, being hard work even for a fast PC. It is often 

sufficient to load the data from a result file selectively, so that your hardware is used in a 

more rational way. MIKE View gives you a chance to discard the unnecessary data types 

or irrelevant simulation periods, or to reduce the level of time resolution of the displayed 

data. You simply switch ON or OFF certain data types, redefine the time interval for 

loading, and select the appropriate step-loading factor. 
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Figure 8.1 The Data Load Selection View. As default, MIKE View proposes the complete result 

file to be loaded 

 

The tutorial result file is fairly small, and you should simply confirm the default selection by 

clicking on the <OK> button. After a short while, the file is loaded and MIKE View opens 

two new windows. 

 

8.7 Exploring the MIKE View Screen 

MIKE View has opened two windows: 

• Horizontal Plan window 

• Plan Overview window 

Please note: 

If your MIKE View ‘remembers’ some other settings from the previous session, the Palette 

window may also be on the screen, and the Horizontal Plan will be coloured. 

 

The Horizontal Plan window dominates MIKE View. It displays the layout of the sewer 

network. If you select the Horizontal Plan window it becomes the active window, and the 

Horizontal Plan toolbar appears under the main menu. 

 

When you move the cursor within the Horizontal Plan window, the co-ordinates of the 

current position are displayed in the status bar, located in the bottom left corner. The 

status bar also provides useful information on the program mode, help text, etc. 

 

The Overview Plan window contains an outline of the network Horizontal Plan. It makes it 

easier to see where in the network you are while zooming. Try to arrange the size and 

position of the MIKE View windows, until you get them in a desired layout. 
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8.8 Viewing System Data 

The best way to get a closer look at the Horizontal Plan is through playing with the various 

options available. 

 

The Horizontal Plan Options View is activated by clicking on the Options tool in the 

toolbar, or by activating the Horizontal Plan local menu (press the right mouse button, 

while in the window). 

 

 
 
Figure 8.2 Horizontal Plan Options View 

 

Let’s first try to understand the modelled network. The various options available in MIKE 

View have been designed exactly to facilitate this activity. 

 

Try the different options from the Plan Type group. Select one of the drawing modes 

featuring the system information, e.g. by selecting ‘Slope’. This may give you a first 

impression of the topographical layout of the network: the slopes of the links will be 

displayed as a palette of colours. Furthermore, you may select ‘Slope’ under the ‘Symbols 

and Fonts’ group, which will add arrows to the links, indicating the direction of the slopes 

(works only if ‘Slope’ has been selected under ‘Plan Type’). Similarly, if you select ‘Bottom 

Levels’, the colour palette will illustrate the bottom level of the Riverbed.  

 

Under the ‘Symbols and Fonts’ group, you may adjust the size of symbols and the 

thickness of links and select your preferred font type and size. 

 

Further, the system can be explored by selecting and viewing the longitudinal profiles 

along various selected paths. 
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Figure 8.3 The network plan plot 

 

Zooming 

The zoom function is available in all of the MIKE View graphical presentation windows. It 

is activated by choosing the various zoom tools in the toolbar, or by selecting <Zoom In>, 

<Zoom Out> or <Zoom Previous> in the local menu. 

 

If you choose ‘Zoom In’ the cursor changes to a magnifying glass symbol. Move it to the 

location on the plan plot, which should be one of the corners of the zoomed-in frame. 

Then press the mouse button and drag the cursor across the Horizontal Plan. The cursor 

has again changed shape, and the zoom frame rectangle indicates the area, which will be 

included into the zoomed Horizontal Plan window. Continue the dragging until you are 

satisfied with the area included. Release the mouse button, and the displayed part of the 

network Horizontal Plan reduces to the framed area only. 

 

The scroll bars of the Horizontal Plan window make it possible to ‘pan’ the zoomed frame 

over the network area. Also, you can drag the zoom frame rectangle in the Overview 

window over the network area to the desired position. 

If you would like to see the whole network again, use <Zoom Out> or <Zoom Previous> 
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8.9 Viewing Results 

Selecting result variable and plot type 

Under the Horizontal Plan <Options><Plan Type> select one of the result variables. You 

may notice that the result variables are divided into two groups: some variables are 

attached to network nodes, and others are attached to links. 

At first, if you have more than one result file loaded into MIKE View, you should select the 

desired file. Then, you select a desired variable from the list of the available variables. 

 

Finally, you select a mode for the presentation. The results may be viewed as animation, 

as minimum results or as maximum results. Selection of ‘Min’ or ‘Max’ results in the lower 

or upper envelope for the selected variable being displayed as static Horizontal Plan plot. 

If you select Animation, the selected variable will be displayed dynamically, as a replay of 

the simulation through time. We will choose the animation. 

 

The only file available (i.e. loaded in MIKE View) is the TUTOR1.PRF. Choose the group 

of variables related to links, and select ‘Discharge Branches’ (i.e. Links). Check if 

‘Animation’ is selected as the plot type. 

 

When you are done, click <OK>. MIKE View now displays the discharges in the 

Horizontal Plan, corresponding to the start time of the simulation. 

 

Note the date and time indicator in the upper part of the Horizontal Plan (the ‘Clock’). The 

‘tape recorder’ buttons in the toolbar have been activated, too.  

 

Animation in the horizontal plan 

If you click on the run button, the animation will start. You may notice that the time 

elapses in the ‘Clock’, and that the colours on the plan plot are changing, following the 

discharge dynamics. 

 

Try the other animation functions: Pause, Stop, Step Forward and Step Backward. The 

functionality is the same as controlling a tape recorder. 

 

Under the Main menu <Animation><Advanced>, you can adjust the speed of the 

animation and some other parameters. Try and see the difference. 

 

Flooding and depth 

MIKE 11 computes absolute water levels. However, it may be of a particular interest to 

see where flooding occurs in the system. MIKE View can compute the flooding as a new 

variable, which you can view as any other result variable. 

 

In the Main menu choose <Tools><Compute><Flood>. As soon as you click with the 

mouse, the flooding is computed for the whole system, and added on the list of the 

available variables (in the Options View). 

 

Go back to the Horizontal Plan window and select ‘Flood’ in links under <Options> of the 

local menu. Change the plan type to ‘Max’ and click <OK>. Your Horizontal Plan now 

displays the upper envelope of the flooding, which occurred during the simulated event. 

You can also view the dynamics of the flooding, simply by switching to the plot type 

‘Animation’ and pressing the ‘run’ tool. 

 



 MIKE 11 

72 River and Channel Modelling - © DHI 

Additionally, the actual water depth of a certain location can be of interest. Compute also 

depth in the system. Show these variables as ‘Max’ and as ‘Animation’, see Figure 8.4. 

 

 
 
Figure 8.4 Maximum Depth for the simulated event 

 

Adjusting Min/Max range and colour palette 

In reality, you are not interested in seeing the ‘negative’ flooding displayed, i.e. the 

situation where the water levels are contained within the surface levels as specified in the 

MIKE 11 model. This problem can be easily solved, by adjusting the ‘Min’ and ‘Max’ of the 

displayed range. 

 

Activate the <Change Palette Intervals> function in the Horizontal Plan local menu, and 

change the ‘Min’ to zero. You may also change the ‘Max’ value to be some round number. 

Confirm your settings and have a look at the plan plot: Initially, the whole network is grey, 

indicating that there is no flooding. When you start the simulation, only those parts of the 

system where the flooding actually occurs changes colours, according to the palette. 

 

The palette may be controlled in many ways. Click the right mouse button while in the 

palette window, and examine the possibilities.  

 

If you do not like the colours on the palette, you may change them with the palette editor. 

Just double-click on the colour you want to change, and the editor opens. Similarly, if the 

range intervals are not suitable for your presentation, double click on the value, which you 

want to edit. 

 

It is recommended that you spend some time playing with the palette. It will pay-off when 

you can efficiently apply your new experience in future work. Moreover, if you create a 

custom palette of a more general applicability, or if you want to have it at hand next time 

you work with MIKE View, just save the palette settings into a PAL file. Next time, load it 

and your own palette will be there again. 

 



MIKE View Tutorial  

 73 

Exporting the horizontal plan 

You will often be in a situation, where you want to include some of the MIKE View graphs 

into your text report. With MIKE View there is nothing easier. 

 

Of course, your word processor should be a true Windows application with Copy and 

Paste facilities, e.g. Word. Start it, and open your report document (or create a new one 

for the exercise). 

 

Return back to MIKE View, adjust the Horizontal Plan to fit your needs in the report, and 

activate the local menu. Simply click on the <Copy Graphics > option. Apparently, nothing 

happens, but actually, the content of your Horizontal Plan has been copied to the 

Windows Clipboard. 

 

Switch again to the text editor, position the cursor at the desired location, and activate the 

standard <Edit><Paste> function. The MIKE View plot is pasted into your document as a 

fully vectorised graphical image, which opens the possibilities for resizing and editing. 

 

This facility works for any graphical window in MIKE View. 

 

8.10 Viewing Results in a Longitudinal Profile 

The Horizontal Plan is the working area where items may be selected for all the other 

presentation modes: longitudinal profile, time series, Q-H relations and Cross-section 

animations.  

 

Selecting a longitudinal profile 

Let’s assume that we want to have a look at the longitudinal profile of the main stream 

starting from upstream point and down to the boundary point where the river has its 

connection with the sea. 

 

Click on the Longitudinal Profile tool in the toolbar  and point with the cursor in the 

vicinity of the upstream point of VIDAA-OVR (ch 108 m). When the cursor changes to an 

arrow, it means that you can start the selection of the longitudinal profile.  

 

Click on the branch, and the VIDAA-OVR branch changes colour to green. Continue the 

selection by clicking at each branch (or in the direction) along the desired path. MIKE 

View paints your selections bold green. When you arrive to the last branch, MIKE View 

recognises the end of the path and proposes that the selection is closed. Confirm and 

choose the type of variable, which you would like to show in the longitudinal profile. The 

default selection is ‘Water Levels’. 

 

Note:  

If you have selected a wrong branch, ‘deselect’ the last selected branch by clicking on the 

mouse button and pressing the Shift key at the same time (or simply press Backspace). 
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Animating a longitudinal profile 

At first, resize and reposition the Longitudinal Profile window, until you are satisfied with 

the appearance. You can also, as in the Horizontal Plan, zoom-in, zoom-out and control 

various display options by opening the Options View from the local menu. 

 

The animation is started in exactly the same way as in the Horizontal Plan: Just click on 

the ‘Run’ tool in the toolbar.  

 

Synchronising animations 

If you want, the animation in two or more windows can be fully synchronised. This means 

that the animation in each of the open Horizontal Plan and Longitudinal Profile windows 

will elapse synchronously and that you can follow the system dynamics from several 

‘angles’ simultaneously. 

  

You can only have one Horizontal Plan window opened with each of the result files 

loaded. But, if you load more result files (e.g. one from MIKE 11 and the other from 

MOUSE or two MIKE 11 result files), a synchronised animation can be made also for two 

Horizontal Plan windows.  

 

To make sure that your windows are ‘synchronised’ select <Animation><Synchronize All 

Plots>. Next time you start the animation, all windows will be in motion. 

 

Each of the windows can individually be excluded from the synchronised animation. This 

switch is available under the local menu of the window. 

 

8.11 Viewing Time Series 

Time series graphs are usually the most relevant graphs for the system analyses. MIKE 

View allows you to see any of the existing time series from the loaded result files, to view 

them in combination with the measured data, and to create time series graphs with all 

possible time series combinations. 

 

Selecting a time series 

Let’s assume that the water level is of our primary interest. Click the  button; ‘Select 

Gridpoint’ in the toolbar and select ‘Water Level as the variable. Select the RES11 file (in 

case you have multiple files added to the current project), and either point the cursor to a 

point in the horizontal plan or press the ‘List’ button to select the Time series location from 

a table. Please note that if you select the point from the plan plot, you are kept informed in 

the info bar (lower left corner of the MIKE View window) on which point you are actually 

pointing at.  

 

The cursor changes to an arrow if you are pointing at a point equal to the item you have 

just selected (= Water level) indicating that here data are available After clicking with the 

mouse, MIKE View opens a window with a graph showing the Water level for the actual 

point. 

 

Try also to select a Time Series from the Time Series List selection window.  
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Similarly, as in the longitudinal profile window, you can control the appearance of this 

window in many ways with the right mouse pop-up menu. Try to open the ‘TS Settings…’ 

under ‘Options’ in the pop-up menu. Here, you can change the thickness, colours and 

other settings for appearance of individual series in the actual window. 

 

Adding items to a time series graph 

You can complement any time series graph with as many other time series of the same 

data type as you wish (e.g. Water Level). Additionally, you can add data of a different data 

type to the same windows – max 2 data type area allowed within a Time Series window. 

These may come from the same result file, from some other loaded result file, from a 

separate DFS0-file, from the MIKE 11/MOUSE time series databases, from the Clipboard 

or from a text file. 

 

Just for the exercise, let’s view the water level in a specific point in combination with a 

discharge time series from an external DFS0-file. 

 

Press the Time Series tool button, select ‘Water Level’ and press the List button. In the list 

of calculation points go down to the point ‘VIDAA-OVR 4822.00’ and select this point by 

activating the check mark in the first column. Press the ‘Draw Graph’ button to draw the 

Time Series in a new Windows. After this, open the right mouse pop-up menu and choose 

<External TS>, in order to open the External Time Series View. 

 

 
 
Figure 8.5 The External Time Series View 

 

Click on the <Load DFS0> button and find the file; M4234-Q.DFS0. Select the file and 

MIKE View are loading the time series, which can then be used for comparison with the 

simulated series  

 

In order to get the time series displayed in the graph, you should select it by clicking with 

the mouse on the time series identifier. Before confirming your selection with <OK>, 

select ‘Use second y-axis’ from the list. This will cause the Water level and the discharge 

to be shown with each their y-axis. 
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9 Demo Set-ups Included in the Installation 

9.1 Introduction 

Setting up a river model – especially for new users of MIKE 11 – typically introduces 

some initial problems on how to schematise the natural river in the mathematical model, 

which input data are required, how to combine the measured series of hydrometric data 

and topographical surveys etc. etc. To reduce the amount of initial difficulties in the 

process of setting up a river model for the first time, it is often beneficial to obtain 

experience from already existing river set-ups. 

 

Included in the MIKE 11 installation, you will find examples of river model set-ups 

including all required data input files to perform simulations with MIKE 11. The two basic 

examples comprises a set-up for a Danish stream (small river) named ‘Vida’ and a 

reduced set-up for a river in Bangladesh named ‘Cali’. 

 

Input files for the demonstration set-ups are automatically installed to your computer when 

installing MIKE 11. Input data comprises files for the River Network, Cross-sections (River 

topography), Boundary definitions, hydrometric time series data and HD parameters. 

 

After installing MIKE 11, the demonstration set-ups are located in the installation folder in 

the following directories: 

‘…\MIKE Zero Projects\MIKE_11\Vida’ (Vida Stream) 

‘…\MIKE Zero Projects\MIKE_11\Demo’ (Cali River) 

 

Additionally there are three examples of using the auto-calibration feature of MIKE 11:  

‘…\MIKE Zero Projects\MIKE_ZERO\AutoCal\MIKE_11\Example1’  (target: Resistance)  

‘…\MIKE Zero Projects\MIKE_ZERO\AutoCal\MIKE_11 Example2’  (target: RR)  

‘…\MIKE Zero Projects\MIKE_ZERO\AutoCal\MIKE_11 Example3’  (target: AD)  

 

9.2 How to Use the Demonstration Set-ups 

A source of inspiration for own projects, or an exercise for inexperienced users to 

familiarise themselves with the various editor features and functions of MIKE 11. This 

could be some of the achievements for users when examining and working with the 

demonstration set-ups. 

 

MIKE 11 works both as a Demo version (without a software key and valid license files) 

and as a Full version (with software key and valid license files). If MIKE 11 works as 

Demo version, several limitations apply compared to the Full version. All editors are 

accessible and operate as in a full version, but restrictions apply for the number of data 

objects allowed when saving editor data files.  

 

 

Limitations for a Demo version are:  

• max 50 grid points in the river set-up, 

• max 3 river branches, 

• max 1 hydraulic structure, 
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• max 1 Q/h boundary, 

• max 1 NAM catchment, 

• max 10 cross-sections, 

• max 3 time series items containing max 50 time steps 

 

The enclosed two set-ups differ from each other primarily by the number of data objects 

included in the set-up; 

 

The Cali river set-up has been reduced from the original size in order to comprise the 

limitations of the MIKE 11 Demo version. It is therefore possible to modify and save input 

data, perform simulations and view results from simulations which means that also users 

working with the Demo version can use the Cali set-up as an exercise to familiarise 

themselves with MIKE 11 and eventually make a set of ‘what-if’ scenarios.  

 

For example, what happens if I change the Manning number globally? What happens if I 

change the boundary conditions? What happens if I change the shape of cross-sections? 

Etcetera, etcetera. 

 

The Vida river set-up comprises a fully, non-reduced river set-up. The amount of data and 

number of data objects significantly exceeds the limitations of MIKE 11 Demo version, 

and therefore, it is not possible modify and save the content of the data files in the Vida 

set-up if you are working with the Demo version. In this case, it is only possible to open 

the data files, view the content and obtain knowledge on how the river system is defined – 

the date files cannot be re-saved due to the large amount of data. 

 

9.3 Cali River 

The enclosed Cali River set-up has been modified to reduce the original number of input 

elements (cross-sections and river branches) to keep within the limitations of MIKE 11 

Demo version.  

 

The set-up comprises 3 river branches and 10 cross-sections. The boundaries consist of 

a single recorded upstream inflow and two downstream water levels conditions. A plan 

plot of the Cali River set-up is presented in Figure 9.1. 
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Figure 9.1 Cali River, plan plot of MIKE 11 set-up 

 

The input files are all located in the ‘…\Examples\Mike_11\Demo’ directory. To load the 

files select File Open (Ctrl+O), change directory to Examples\Mike_11\Demo in the File 

selection box and select the file type you wish to load (e.g. Time series file, simulation file, 

network file, etc.). 

 

When integrating information from the pre-defined editor files, you should initially open the 

simulation editor file (Cali.Sim11). Select the ‘Input’ property page and open a specific 

editor by pressing the ‘Edit...’ button. 

 

Please note that two boundary files are enclosed. The two files illustrate two different 

methods for defining boundary conditions (i.e. by extracting time series items from either 

one or several Time series files). 

 

1. ‘CALI1.BND11’ 

The three boundary conditions are defined by extracting time series items from three 

different Time series files (*.Dfs0). Each time series file contains only one item. 

 

2. ‘CALI2.BND11’ 

The three boundary conditions are defined by extracting time series items from only 

one Time series file. The current Time series file contains three items. 

 

Using the pre-defined settings in the Simulation editor for input files the simulation period 

and time step, it is possible to perform a simulation and view the results in the result 

presentation programme, MIKE View. 
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9.4 Vida 

The second example is a set-up from a stream (small river) in Denmark, named ‘Vid-Å’. 

The set-up was developed by DHI for a project conducted in 1997. 

 

The Vida set-up comprises a main river branch with several smaller tributaries feeding 

into the main river. Boundary conditions are defined as inflow hydrographs on all 

upstream boundaries and a downstream tidal boundary at the sea. The downstream 

boundary is defined by applying measured water levels covering a large number of tidal 

periods. 

 

Input files for the Vida set-up are located in ‘…\Examples\Mike_11\Vida’. All input files 

required to perform the hydrodynamic computation are present. Additionally, two 

graphical files (.GIF) are enclosed each containing a scanned map of the study area. The 

scanned images are provided as high and low resolution (200 dpi or 400 dpi). 

 

 
 
Figure 9.2 Vida, plan plot of MIKE 11 set-up including background map 
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